Introduction

Congratulations on your choice of a state-of-the-art
WizCom QuickLink Pen™. Inside its tip your Pen contains a
sophisticated electronic eye mounted above two rollers.
This eye enables you to scan in different types of printed
information, such as notes, addresses or business cards,
Internet links and tables, anywhere you are. You can later
transfer, or “quicklink”, the information to your computer.

Introduction

Your QuickLink Pen comes with a QuickStart guide so that
you can start scanning information into your Pen right away.
It also comes with a CD-ROM that contains the QuickLink
Desktop application; a library of for expanding your Pen’s
capabilities; a complimentary copy of CharacterEyes
Limited, Ligature Ltd.’s popular optical character recogni-
tion (OCR) software, enabling you to work with TWAIN-
compatible, flatbed scanners; and a movie about the Pen.
Use QuickLink Desktop to exchange information between
your Pen and computer or to customize your Pen by adding
and removing components such as applications and
dictionaries. In addition, QuickLink Desktop enables you to
use the Pen as an input scanning device.

The QuickLink Pen can be upgraded. You can purchase a
larger flash memory card for your Pen to greatly increase its
capacity for adding components and applications.

Your Pen comes with a warranty form. Fill it in and send it
to the retail outlet where you purchased your unit. WizCom
does not accept any direct or indirect liability for financial
losses or claims from third parties, resulting from use of this
product and all its functions, or for any damage caused by
its improper use. WizCom reserves the right to make
technical alternations.
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How To Use this Manual

The QuickLink Pen Operations Manual is designed to help
you get the most out of the varied and sophisticated
functions the Pen and accompanying Desktop application
make available to you. Each section explains one or more
functions in full, and the Index at the end of this manual
helps you find particular options or steps in a procedure.
The manual is divided into the following four sections:

Part 1: Getting Started

In The QuickLink Pen and Learning to Scan sections, you
will learn how the QuickLink Pen works and follow basic
instructions for using it to scan in a simple line of text. In
the Setting Up the Desktop section you will find instructions
for installing the QuickLink Desktop software from the CD-
ROM, and for setting up communications between your Pen
and computer. This enables you to transfer the information
you have scanned into applications on your computer (e.g.,
you can transfer the Internet Links you have scanned to
your web browser’s “Favorites” list), and to use your Pen to
scan information directly into your computer.

Part 2: The QuickLink Pen

Detailed, step-by-step instructions for all the QuickLink Pen
Main Menu options are given in the Main Pen Functions
section. Here you can find out how to scan in plain text,
addresses, Internet links, and tables: scan directly into an
application on the computer; transfer data between your Pen
and computer; change the Pen’s default settings; and access
information about the Pen’s present status. The following
section, Advanced Pen Features, explains how to edit
information you have scanned in using the Edit Menu and
Character Bar. It also shows you how to enter information
manually using the Opticard.



Part 3: The QuickLink Desktop Application

The Introduction to the QuickLink Desktop section explains
what the Desktop components and functions do. In the
following section, QuickLink Desktop Functions, you can
find detailed instructions for managing your Pen and data
files, communicating between the Pen and computer, adding
and removing Pen components such as OCR or interface
languages, and backing up or restoring Pen data, applica-
tions and components.

Part 4: Appendices

In the Additional QuickLink Pen Information section you
will find instructions for upgrading your Pen and maintain-
ing it, as well as technical specifications. The Technical
Data and Troubleshooting sections complete this last part of
the manual.

Conventions

The following conventions are used to present information
in this manual:

. Pen and Desktop menu options are displayed in bold
type. For example, the New Link function in the
Internet Links application on the Pen or the Add/
Remove Pen Components function in the Desktop
Pen Communications menu.

° In the instructions, the word “select” means “scroll to
... and press the @ button”. For instance, “Select
OK” means to “scroll to OK, then press @™,

. Sections of this manual referred to by their specific
name are written in italics (e.g., the section Using the
Character Bar).
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Part 1: Getting Started
The QuickLink Pen

Package Contents

Before using your Pen, take time to check the package
contents to make sure that you have received all the
following items. If anything is missing, contact your
QuickLink Pen dealer.

. QuickLink Pen (in Pen case)

*  Pen case with Opticard sticker on the bottom
. QuickLink cable

e Two AAA batteries

. QuickLink CD-ROM

e  Warranty card

*  Operation manual

. Quick-Reference card

*  QuickStart guide

Familiarizing Yourself With the Pen

Your Pen contains the following parts:




 Tip §
. Protective cover =
o Power button xn
* Key pad %”
e Display g

&}
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e Battery compartment cover
*  Battery compartment
¢ Flash memory card pocket and connector

PC Link Connecior

. PC link connector
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Setting Up Your Pen
Step A. Insert Batteries

Remove the battery compartment cover from the back
of the Pen.

Insert two AAA batteries (included in packaging) in the
correct direction.

Replace the battery compartment cover.

Step B. Remove Protective Cover

Before scanning, always remove the protective cover from
the tip so that the electronic eye is exposed. Always replace
the cover when you are done scanning.

Basic Pen Commands

The Pen Buttons and Their Basic Functions
The keypad contains seven buttons for operating your Pen.
The basic functions of each button are listed below.

Button Function

© Turns the QuickLink Pen on and off.

@ Enters a menu option or a command.
Switches the Pen to scan or edit mode.
Toggles a checkbox on or off; [x]= on.

) Returns you to the previous menu.
Closes a pop-up alert or message box.
Exits the Edit menu.

® Scrolls you upward to the next line in a

menu, list or file.




Button Function

® Scrolls you downward to the next line in a
menu, list or file.
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® Scrolls you to the right within an option,
line of text or a table.
Toggles a checkbox on or off;[X]= on.

@ Scrolls you to the left within an option, line
of text or a table.

Toggles a checkbox on or off;[X]= on.
When in View Addresses list, displays the
Addresses menu.

When in View Links list, displays the
Links menu.

Double-Click
To double-click an arrow button, press on the button twice
in rapid succession.

Long-Press
To long-press an arrow button, depress the button and hold
it down briefly.

Navigating Menus, Options and Lists

The QuickLink Pen features a Main Menu, which is

comprised of a series of applications and menu items. Each
application or menu item you select contains a submenu of
options that tell the Pen to perform a specific function.

Some of the options you select may contain a further list of
choices. n
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To select an application, menu item or option:

1. Scroll through the menu using ® or ®.
2. Press @,

To select an entry from a list:

1. Scroll through the list using ® or ®.
2. Press®,

To select the OK button:

1. Scroll to the OK button, if necessary, using® or ®.
The button should be highlighted.
2. Press @,

Error Messages

If an error occurs during operation of your Pen, such as
scanning a line of text too quickly, an error message appears
on your Pen’s display. To close the message, press @,

Confirmation Message.

A confirmation message appears when you delete a file or
entry from your Pen. To select Yes to close the message,
press @ To cancel the delete action, press ® to scroll to
No, then press @,

Scanning Limitations

Your Pen allows you to scan in printed text 6-22 points in
size (up to 8 mm) in a wide variety of fonts and in all colors
on contrasting backgrounds except:

e red on white
e white onred
*  blue on black
e black on blue



Learning to Scan

This section takes you step by step through the process of
scanning simple text into the QuickLink Pen, using the
Notes application as an example. Once you learn the basics
for scanning Notes, you will be able to use your scanning

skills for the rest of the QuickLink applications and functions.

Step A. Turn Pen On
Before scanning, remove the protective cover from the tip
and press @ to turn on the Pen.

Step B. Go to Pen Main Menu

The first time you turn your Pen on, the Main Menu
appears. If the Main Menu does not appear in the Pen
display, press & to return to the Main Menu.

Step C. Switch to Left-Handed Use (Optional)

If you are left-handed, switch the Pen to left-handed use

prior to scanning:

1. Scroll to the Preferences menu using ® or ®, then
press @,

2. Scroll to the Right-/Left-Handed option, then press @,

3. With the Left-Handed option displayed, press @. The
text changes position on the display.

4.  Switch the Pen to your left hand.

5. Press & to return to the Main Menu.

Scanning instructions are the same for left-handed users.

Step D. Select Notes Application
Scroll to Notes using ® or @, then press &,

Step E. Select New File Option
The New File option is highlighted. Press @ to select this
option.
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Note: If New File is not highlighted, scroll to New File
using ® or @, then press @.

Step F. Assign File Name
The new Note file is assigned a name automatically. Press
® to scroll to OK, then press @ to accept the file name.

You are now in the Note file. A blinking red light appears in
the Pen’s tip, signifying that you are ready to scan.

Note: The blinking red light should be on each time you
are about to scan. If the light does not appear, press € to
return to the previous menu, then repeat the steps that take
you to the scanning function.

Step G. Scan First Line of Text
1. Place the rollers about 1/2 inch (1 cm.) before the
beginning of the first word of the sample text below:

With a QuickLink Pen you can scan text anywhere,
even atop Mount Everest

2. Hold the Pen with the tip at a 75°-90° angle from the
text you are scanning, with the rollers lightly touching

the page.




3. Scan gently from left to right. Make sure to keep the
center of the Pen tip aligned with the center of the
letters in the line of text while you scan.

4.  When the rollers have passed the end of the line of
text, lift the Pen off the page. The text appears in the
Pen display.

Step H. Rescan Inaccurate Text (Optional)

If the scanned text contains errors and must be rescanned,
press @ to erase it, then repeat Step G above. Otherwise,
advance to Step 1.

Stepl. Scan Next Line of Text

If the scanned text is correct, repeat the scanning process in
Step G above. The Pen inserts a space between the two lines
you scanned.

Step J. Start a New Paragraph
To create a new paragraph, press ® before scanning in the
next line of text.

Step K. Saving the Note

When you have finished scanning the Note, press & twice.
The Pen returns to the Notes menu. The text you have just
scanned is saved to your Pen automatically.

Setting Up the Desktop

While the Pen can be used as a stand-alone device, having
the Desktop up and running enables you to scan from your
Pen to your computer, quicklink information between the
Pen and computer, and perform various other Pen-computer
communications.

2
=
N
<
|70}
D
=]
)
=
N
=)
-
en
=]
o
=
53
7]




2
S
N
=<
170]
D
a
=]
=
N
2
-
0
=
- p—
=
"3
»n

Desktop Installation
The QuickLink Desktop installation allows you to perform
four functions:

Install the QuickLink Desktop application on your computer.
Install additional interface languages for the QuickLink

Desktop.

Run the Pen-Desktop Communications Wizard to set up
communications between your Pen and computer.

Run the Pen Customization Wizard for adding OCR and
interface languages to your Pen so that you can use it in
a foreign language.

To perform the latter two functions, you will need your Pen
and the QuickLink communications cable (if you are using
serial port communications) or external IrDA device (if you
are communicating via infrared technology).

To install QuickLink Desktop:

1.

Insert the QuickLink CD-ROM into the CD drive on

your computer. If the Setup does not begin automatically:

*  Click on the Windows Start button and select Run.

*  Type x:\setup.exe (where x is your CD-ROM
drive), then click on OK.

Click on install products, then select quicklink desktop.

If you have a multi-language version of QuickLink

Desktop, select the setup language you want from the

drop-down list, then click on OK.

The Installation Wizard guides you step by step

through the installation. You are advised to:

*  Click on Yes when asked whether you want to
launch QuickLink Desktop upon startup. This runs
the Desktop application every time you use Windows.

*  Run the Pen-Desktop Communications Wizard.
The wizard gives you simple, step-by-step



instructions for setting up communications
between your Pen and computer. Pen-computer
communications setup is usually a one-time
process and does not need to be repeated. If you
require additional instructions for connecting the
QuickLink cable or external infrared device to
your computer, please refer to the following
section, Connecting the Communications Cable or
External Infrared Device.

Once QuickLink Desktop has been successfully installed,

you can also:

e Install CharacterEyes Limited for QuickLink, a comple-
mentary copy of Ligature Ltd.’s popular omnifont OCR
desktop software. CharacterEyes Limited provides a
powerful, yet easy-to-operate, tool for scanning
documents, analyzing their layout and retaining the text
attributes to your Desktop software.

e View a movie about the QuickLink Pen.

¢ Browse the contents of the CD-ROM, including the
documentation.

¢ Contact WizCom Technologies in order to register your
QuickLink product.

The CD serves as a library of Pen components. Save the CD
and use it when you want to add components to your Pen
according to the Adding and Removing Pen Components
section later in this manual.

Note: The setup may tell you at the end of installation to
restart your computer. If it does so, please restart your
computer so that QuickLink Desktop and other applica-
tions will run properly.
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Connecting the Communications Cable or
External Infrared Device

The QuickLink communications cable or external infrared
device enables the flow of data between the Pen and computer.

QuickLink Communications Cable
The cable is used for serial port communications. It has a
connector at each end, which must be attached to the
appropriate hardware:
*  9-pin serial connector for attaching to the serial
port on the computer
e Cable plug for attaching to the Pen

To connect the cable:

1. Locate the 9-pin serial port on the back of your computer.
Plug the 9-pin serial connector into the serial port.

Insert the cable plug in the PC link connector on the
bottom of the Pen.

2.

External Infrared Device

The infrared device contains a 9-pin connector at one end,
which must be attached to the back of the computer. To
connect the device, plug the connector into the serial port on
your computer.

If no 9-pin serial port is available on your computer, use a



25-t0-9-pin adapter (not included) and attach the cable or
infrared device to a 25-pin port.

Running and Exiting the Desktop
Running the Desktop

In order to run the Desktop program:

e If, during installation, you chose to add the Desktop to
your computer’s startup: Click on the Desktop status
indicator icon in the task tray at the bottom of the
screen, then select the Show Window option.

e If the Desktop application does not run when you start
up or if you closed the application: Go to the Windows
Start menu and select Programs\QuickLink
Desktop\QuickLink Desktop.
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Exiting the Desktop

To exit QuickLink Desktop, select Exit from the File menu.
Or click on the Desktop status indicator icon, then select Exit.
Pressing ALt+F4 or clicking ﬂ in the upper-right corner
of the Desktop window hides the Desktop window. The
application continues running in the background.

Registration

Before you begin using your Pen and Desktop application,
take time out to register your QuickLink product at the
WizCom web site. To register:

1. Select contact us from the CD-ROM Installation main
menu, then select registration. Or, select Register at
WizCom Site from the Help menu of the QuickLink
Desktop application. Your web browser opens the
Internet link for the registration page on the WizCom site.

2. Follow the on-line instructions for complete registra-

oltow
tion of this product.



i} Part 2: The QuickLink Pen
-l Main Pen Functions
=
il Overview
.§ The Pen Main Menu contains the following nine options:
S

Notes

The Notes application enables you to scan printed text, such
as excerpts from journals and books, into your QuickLink
Pen. This text can later be quicklinked into Microsoft®
Word, Microsoft® Outlook® or other host applications on
your computer.

=
Address Book

The Address Book application enables you to scan business
cards and other addresses into your Pen. The information
can later be quicklinked into Outlook or other host applica-
tions on your computer.

Internet Links

The Internet Links application enables you to scan Internet
Links into your Pen. The information can later be
quicklinked into the Favorites folder in Microsoft Internet
Explorer® on your computer.

Tables

The Tables application enables you to scan Tables into your




Pen. The Tables can later be quicklinked to Microsoft®
Excel on your computer.

Scan to PC

The Scan to PC application enables you to use your Pen to
scan text directly into an application on your computer.

QuickLink

Activates the QuickLink process, which exchanges informa-
tion between your Pen and computer.

PC-Controlled Communications

Initiates communications between your Pen and computer
so that you can add and remove Pen components such as
OCR and interface languages, or backup and restore Pen
data, applications and components.

Preferences
Contains options for changing settings on your Pen, such as
the scanning language and the menu type.

Information
Contains options that display information about your Pen’s
current status.
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Note: The first time you turn on your Pen, it opens in the
Main Menu. For successive QuickLink Pen sessions, it
opens in the last application in which you worked. If you m



want the Pen to open in the Main Menu, keep &
depressed while you turn on the Pen.

The Main Menu Options
Notes

The Notes application enables you to scan printed text into
your QuickLink Pen. The Notes menu contains the follow-
ing options:
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Edit Current File

The last file you worked in during your previous QuickLink
Pen session is called the current file. Select Edit Current
File to open this file so that you can continue scanning in
text or edit the existing text.

New File

This option creates a new Notes file. When you select this

option, a name is assigned to the file automatically.

However, you can enter a different file name. To create a

new file:

1. Select New File.

2. If you want a different file name, scan in the name you
want. The Pen saves up to eight characters in the name.

3. Select OK.

Once you have created a new file, you can begin scanning

in text. To scan in text:

1. Scan in each line of text in its entirety. Each successive
m line of text is entered into the file as a continuation of



the first line, with a space inserted after the last word in
the last line you scanned.

2. If the line of text you have just scanned is inaccurate
and you want to rescan it, press @ to delete it, then
scan again.

3. To insert a new paragraph before scanning the next line
of text, press @.

4. When you have finished scanning, press & twice. The
text you have just scanned is saved to your Pen.
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Note: You can create a maximum of 200 Note files. To
create a new file once the file list is full, delete one of the
existing files.

Open File

Use this option to open an existing Note that is not the
current file. You must open a Note prior to viewing or
modifying it. If you do not select a file using this option, the
application opens the current file.

1. Select Open File.

2. Select the file you want.

Delete File

Use this option to delete a file from Notes.

1. Select Delete File.

2. Select the file you want to delete.

3. Select Yes when the confirmation message appears.

Exit

Select Exit to return to the Main Menu.

About
Select About to view information about the Notes applica- m
tion, including the current version number.



Address Book

The Address Book application enables you to scan in and
create a database of addresses and contacts on the
QuickLink Pen. It contains the following options:
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New Address

Use this option to scan in a new Address.

1. Select New Address.

2. Scan the first name of the Address entry into the First
Name field. The Pen scrolls automatically to the Last
Name field.

3. Scan the last name of the entry into the Last Name
field. The Pen scrolls automatically to the next field.

4. Continue scanning the required information into each
field in the Address. To skip a field, press ®.

5. If afield is inaccurate and must be rescanned, press ®
to scroll back up to the field, then rescan.

6. When you have finished scanning, select OK. The
Address you have just scanned is saved to your Pen.

Note: If the information you have scanned exceeds the
width of the display, you can see the entire text by
selecting the Address using the View Addresses option,
below.

View Addresses
Use this option to view the Addresses you have scanned into
your Pen.
1. Select View Addresses.
E 2. Select the Address you want to view. The Address



appears in View Mode; you can scroll through the
entry to view it, but cannot make any changes.

Note: If you have created additional Address files using
the New File option (described below), View Addresses
only displays the Addresses in the current file.

Settings

The Settings option contains features for determining how
you enter Addresses. You can change more than one setting
at a time. Once you have changed the settings, press & to
return to the Address Book menu.

The Settings menu contains the following options:

Scroll Screen

When Scroll Screen is selected, the display scrolls, rather
than jumps, to the next field each time you finish scanning a
line. This is the default.

To toggle Scroll Screen on or off, press @, @ or ®;
=on.

Auto Advance

When Auto Advance is selected, the display moves
automatically to the next field when you finish scanning a
line. This is the default. When Auto Advance is not
selected, you must scroll manually from field to field after
scanning in information by pressing ®.

To toggle Auto Advance on or off, press @, © or ®;
=on.
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AutoName

Select AutoName so that you can scan in both the first and
last names at the same time. The first name appears in the
First Name field and last name appears in the Last Name
field.

To toggle AutoName on or off, press @, @ or ®;
=on.

Next Address Language

Next Address Language enables you to temporarily change
the scanning language for the next Address you scan. The
E-mail and Web Page fields are unaffected by the change
in language.

To change the language prior to creating the new Address:
1. Select Next Address Language.
2. Select the language you want.

Select Fields

Select Fields enables you to select the type of information
you want to scan into an Address entry by determining
which fields are activated. The following fields are activated
until you de-select them:

Title Web Page
Company Home Phone
Address Home Fax
Business Phone Notes
Business Fax

Mobile phone

E-mail

To toggle a field off or on:
1. Select Select Fields.



2. Scroll to the field.
3. Press @, @ or ®; X]=on.
Field Settings

Field Settings enables you to change the default scanning
options for each activated field to increase scanning
accuracy. Select:

e Numeric if you are scanning a string of numbers
so that the Pen knows to read all characters as
numbers.

e Inverse if you are scanning light text on a dark
background.

e Multiple Lines if you want to scan more than one
line of text into a field or cell. This is the default
for the Address and Notes fields.

To set scanning options:

1.
2.

Select Field Settings.

Scroll to the field for which you want to change the
settings, then press @,

Scroll to each option you want to activate.

Press @, @ or ® to toggle the option on or off ;
=on.

Press & to return to the Field Settings menu. Repeat
steps 2-4 for each field whose settings you want to
change.

The Field Settings you specify become the default settings
for the selected field. They stay in effect until you re-select
the Field Settings option and change them. You can
overwrite the scanning options determined through Field
Settings on a one-time basis by pressing @ from the field
you want to scan or by selecting Scanning Options in the
Edit Menu.
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New File

The Address Book application comes with a main file,
called mainadd. Each Address you enter using the New
Address function is stored in mainadd unless you create a
new file. When you quicklink Addresses to your computer,
only the Addresses in the mainadd file can be quicklinked to
the host application.

The mainadd file may be the only Address Book file that
you need. However, you might want to organize your
Addresses differently by creating new files and storing your
Addresses in them selectively.

Use New File to create a new Address file:

1. Select New File.

2. Scan in the file name. The Pen saves up to eight
characters in the name.

3. Select OK.

Important: You can'’t delete the mainadd file from your
Pen.

Open File

Use this option to open an existing file if you have created
your own Address Book files. You must open the file prior
to adding Addresses to it or viewing and editing the
Addresses it contains.

1. Select Open File.

2. Select the file you want to open.

Note: If your Pen contains only the mainadd file, this is
the file that opens each time you select the Address Book
application. If your Pen contains more than one Address
Book file, the last file you used opens automatically the
next time you select Address Book.



Delete File

Use this option to delete a file from the Address Book
application.

1. Select Delete File.

2. Select the file you want to delete.

3. Select Yes when the confirmation appears.

Note: If you delete the current file from your Pen, you
must open an existing file prior to adding Addresses.

Exit

Select this option to return to the Main Menu.

About
Select About to view information about the Address Book
application, including the current version number.

Addresses Menu

The Addresses Menu contains options for finding an
address in the current file, selecting the search language for
finding the Address, and deleting, viewing and editing
Addresses.

To display the Addresses Menu:

1. Select View Addresses.

2. If you want to delete, view or edit an Address, scroll to
that Address.

3. Press®.

Address Menu options are:

Find Address

Use this option to narrow the search for a specific address
when you have a long list of Addresses.

1. Select Find Address. The Character Bar appears. The
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Character Bar contains a series of letters, plus buttons
for selecting punctuation and numbers; use @ or ® to
scroll to each letter or button.

Scroll to the first letter in the Address entry (e.g., the
‘S’ in Smith). The cursor jumps to the first entry in the
list beginning with that letter.

Press @, then scroll to the second letter in the entry
(e.g., the ‘m’ in Smith). The cursor jumps to the first
entry in the list beginning with those two letters.

Press @; if necessary scroll to the third letter in the entry.
When you find the Address you want, press & to exit
the Character Bar.

6. Press @ to select the Address.

Select Search Language

This option enables you to change the language in which
you are searching using the Find Address command:

1. Select Select Search Language.

2. Select the language you want.

Delete Address

Select this option to delete an Address:

1. Select View Addresses.

2. Scroll to the Address you want to delete, then press ©.
3. Select Delete Address.

4. When the confirmation appears, select Yes.

View Address

Select this option to view an Address:

1. Select View Addresses.

2. Scroll to the Address you want to view, then press ©.
3. Select View Address.

The Address is displayed in View Mode. You can scroll
through it but cannot make any changes.



Edit Address

Select this option to display an Address so that you can edit it:
1. Select View Addresses.

2. Scroll to the Address you want to view, then press ©.
3. Select Edit Address.

The Address appears in Scan Only Mode of the Editor. You
can scan in new information or switch to Edit Mode to

modify it. Editing Addresses is explained in detail in the
Advanced Pen Features section of this manual.
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The Internet Links application enables you to scan in and
create a database of Internet Links on your Pen. It contains
the following options:

New Link

Use this option to scan in a new Internet Link:

1. Select New Link.

2. Scan the Link into the Internet Link field. Be sure to
include the www. prefix. When you finish, the cursor
jumps automatically to the Description field.

3. Enter a description that can be used to identity the
Link.

4. Select OK. The Internet Link is saved to your Pen.

Note: If you do not enter a description for the Link, the
Link is entered automatically as the description. E
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View Links

Use this option to view the Links you have scanned in:

1. Select View Links.

2. Select the Link you to want to view. The Link appears
in View Mode; you can scroll through the entry to view
it, but cannot make any changes.

Note: If you have created additional Link files using the
New File option (described below), View Links allows
you to view only the Links in the current file.

Settings

The Settings option contains features for determining how
you enter Links. You can change more than one setting at a
time. Once you have changed the settings, press & to return
to the Internet Links menu.

The Settings menu contains the following options:

Scroll Screen

When Scroll Screen is selected, the display scrolls, rather
than jumps, to the next field each time you finish scanning.
This is the default.

To toggle Scroll Screen on or off, press @, @ or ®;
=on.

Auto Advance

When Auto Advance is selected, the display moves
automatically to the next field when you finish scanning.
This is the default. When AutoAdvance is not selected, you
must scroll manually from field to field after scanning in
information by pressing ®.



To toggle Auto Advance on or off, press @, @ or ®;
=on.

AutoDescribe

When AutoDescribe is selected, the description for a new
Link is taken automatically from the Internet address (e.g.,
the first word after www.). You can edit the description, if
necessary. Editing Internet Links is explained in detail in the
Advanced Pen Features section of this manual.

To toggle AutoDescribe on or off, press @, @ or ®;
=on.

Next Link Language

Next Link Language enables you to temporarily change
the scanning language for the next Internet Link you scan.
The change in language only affects the description.

To change the language prior to creating the new Link:
1. Select Next Link Language.
2. Select the language you want.

New File

The Internet Links application comes with a main file,
called mainlnk. Each Link you enter using the New Link
function is stored in mainlnk unless you create a new file.
When you quicklink Links to your computer, only the Links
in the mainlnk file can be quicklinked to the host applica-
tion.

The mainlnk file may be the only Internet Link file that you
need. However, you might want to organize your Links
differently by creating new files and storing your Links in
them selectively.
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Use New File to create a new Link file:

1. Select New File.

2. Scan in the file name. The Pen saves up to eight
characters in the name.

3. Select OK.

Important: You can'’t delete the mainink file from your
Pen.
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Open File

Use this option to open an existing file if you have created
your own Internet Links files. You must open a file prior to
adding Links to it or viewing and editing the Links it
contains.

1. Select Open File.

2. Select the file you want to open.

Note: If your Pen contains only the mainink file, this is the
file that opens each time you select the Internet Links
application. If your Pen contains more than one Internet
Links file, the last file you used opens automatically the
next time you select Internet Links.

Delete File

Use this option to delete a file from the Internet Links
application.

1. Select Delete File.

2. Select the file you want to delete.

3. Select Yes when the confirmation appears.

Note: If you delete the current file from your Pen, you
must open an existing file prior to adding Links.

Exit

Select this option to return to the Main Menu.

kY



About
Select About to view information about the Internet Links
application, including the current version number.

Links Menu

The Links Menu contains options for deleting, viewing and
editing Links in the current file. To display this menu:

1. Select View Links.

2. Scroll to the Link you want.

3. Press®@.

Delete Link

Use this option to delete a Link:

1. Select View Links.

2. Scroll to the Link you want to delete, then press @.
3. Select Delete Link.

4.  When the confirmation appears, select Yes.

View Link

Use this option to view a Link:

1. Select View Links.

2. Scroll to the Link you want to view, then press @.
3. Select View Link.

The Link is displayed in View Mode. You can scroll through
it but cannot make any changes.

Edit Link

Select this command to display a Link so that you can edit
it:

1. Select View Links.

2. Scroll to the Link you want to edit, then press @.

3. Select Edit Link.
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The Link appears in Scan Only Mode. You can scan in new
information or switch to Edit Mode to modify it. Editing
Links is explained in detail in the Advanced Pen Features
section of this manual.

5]

Tables

The Tables application enables you to scan Tables into your
Pen. It contains the following options:

Edit Current File

The last Table you worked on during your previous
QuickLink Pen session is called the current file. Select Edit
Current File to open this Table so that you can continue
scanning in information or edit existing information

The Table opens to the cell in which you were last working.
You can begin scanning or editing immediately.

Settings

The Settings option contains features for determining how
you enter information in Tables. You can use this option
prior to opening an existing Table or creating a new one.

The Settings menu contains the following options:

Scroll Screen

When Scroll Screen is selected, the display scrolls, rather
than jumps, to the next cell in the Table each time you finish
scanning a line. This is the default.

To toggle Scroll Screen on or off, press @, © or ®;
=on.



Auto Advance
Select Auto Advance so that the display moves automati-
cally to the next cell when you finish scanning a cell.

To toggle Auto Advance on or off, press @, @ or ®;
=on.

Right-to-Left Table

Select Right-to-Left Table to change the direction of the
Table so that the first cell is in the upper right corner of the
Table and the Table scrolls from right to left.

To toggle Right-to-Left Table on or off, press @, © or ®;
=on.

New File

Use this option to create a new Table:

1. Select New File.

2. Scanin a file name. The Pen saves up to 40 characters
for the file name, including spaces.

3. Select OK.

Once you have created a new file, you can begin scanning
in Table information. Information is entered into a Table one
of two ways: with the Auto Advance feature deactivated, or
with Auto Advance activated.

Note: The instructions below describe left-to-right Tables
(the default). For right-to-left Tables, © and ® are
reversed.

Entering Information Without Auto Advance (the default)
1. Scan the information into the first cell in the first row.
Or, scroll to the first cell you want to contain informa-
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tion, then scan it in. If the information you have
scanned contains errors, scan it again.

Press ® to scroll to the next cell in the row, then scan
in the information. The information in the previous cell
is saved automatically to the Table.

Repeat for each cell in the row. When you reach the
end of the row, press @ until you return to the first cell
in the row, then press @ to scroll to the next row and
continue scanning in information as necessary. The
number of columns in the Table is determined by the
longest row.

When you have finished scanning information into the
Table, press @ . The Pen returns to the Tables menu.

Entering Data Using Auto Advance

1.

Scan the information into the first cell in the first row.
Your Pen automatically saves the information to the
Table and jumps to the next cell in the row.

Scan the information into each cell until you finish the

first row. To skip a cell, press ®. If the information you

have scanned contains errors, press @ to return to the
previous cell and scan it again.

When you have finished scanning information into the

first row, define the total number of columns for the

Table one of the following ways:

»  If the number of cells in the first row is the same
as the number of columns you require for the
Table, long-press ©. The display jumps to the
beginning of the row.

»  If the Table requires more columns, press ® once
for each additional column you will need, then
long-press @. The display jumps to the beginning
of the row.

Press @ to scroll to the next row, then begin scanning



information into each cell. When you finish scanning
information into the last cell in the current row, the
display jumps automatically to the first cell in the next
TOW.

5. If] after defining the total number of Table columns,
you require an additional cell at the end of the current
row, press ® prior to scanning information into the last
cell in the row. An additional column is added to the
Table. Now press @ to return to the previous cell and
continue scanning in information.

6.  When you have finished scanning information into the
Table, press &,
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Note: To jump to the edge of the Table in any direction,
long-press the button in the direction you want to jump.

Open File

Use this option to open an existing Table so that you can
view or modify it:

1. Select Open File.

2. Select a file from the list.

Delete File

Use this option to delete a Table from the QuickLink Pen.
3. Select Delete File.

4.  Select the file you want to delete.

5. When the confirmation appears, select Yes.

Exit
Select this option to return to the Main Menu.
About

Select About to view information about the Tables applica-
o . . 37
tion, including the current version number.
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Scan to PC

The Scan to PC application enables you to use your Pen as
an input scanning device in order to scan information
directly into an application on the computer. The Pen enters
the scanned information into the application at the location
of the input cursor.
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The input works in the same way as standard editing using a
keyboard—i.e., highlighted text is overwritten; text is
inserted in Insert Mode or overwritten in Overwrite Mode.

Scan to PC does not interfere with your regular use of the
Windows application.

To use Scan to PC:

1. Make sure that the QuickLink Desktop application is
installed and running.

2. Make sure that communications have been set up
between your Pen and computer:

*  If you are using serial port communications,
attach your Pen to the computer. If you are using
an external IrDA device, make sure the device is
attached to the serial port on your computer.

3. In the Desktop application on your computer, select
Scan to PC Settings from the Pen Communications
menu (or press CTRL+S). The Scan to PC Settings
dialog box appears.

4. Click on the “key” you want to enter after each scan:
*  Space — inserts a space after each scan.

m . Tab — inserts a tab after each scan. (For instance,



when scanning into an Excel table, when you
finish scanning the cursor jumps automatically to
the next cell.)

¢ Enter — The cursor moves to the next line after
each scan.

*  Nothing — Nothing is inserted after each scan; the
next scan continues immediately after the last
character of the previous scan.

5. Click on OK.
6. On your Pen, select Scan to PC from the Main Menu.

Note: Scan to PC mode works in most Windows applica-
tions. However, it may be incompatible with some
applications.

The Scan to PC application on your Pen contains two
buttons: Settings and Exit.

Settings
The Settings menu contains options for determining the
manner in which you scan information into your computer.

Settings options are:

Send Immediately

When Send Immediately is selected, each line you scan in
appears automatically on the computer screen. This is the
default.

To toggle Send Immediately off or on, press @, @ or ®;,
=on.

When Send Immediately is de-selected, each line you scan
appears on the Pen display, and you must press @ to send
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the scanned text to the computer. This is the preferred

setting when your Pen and computer are communicating via

IrDA technology. When Send Immediately is de-selected

you also can:

¢  Scan again to overwrite the current scan prior to

sending.

e Press @ to abort the scan.

e Press @ to save the line and continue scanning. Press ®
after each line you scan; after scanning the last line,
press @ to send all the scanned text to the computer at
one time. You do not need to press ® to save the last
line prior to sending the scan.

Note: If you save too many scanned lines, the “Can’t save
line” message appears on the Pen. Press @ to send the
scanned text to the computer, then resume scanning.

Scanning Options
Scanning Options enables you to adjust the default
scanning options. To select or de-select a scanning option,

press @ @ or ®; =on.

Select:
¢ Numeric if you are scanning a string of numbers
so that the Pen knows to read all characters as
numbers.
¢ Inverse if you are scanning light text on a dark
background.

About
Select About to view information about the Scan to PC
application, including the current version number.

Exit

Select Exit to exit Scan to PC mode.
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QuickLink

The QuickLink option on the Pen initiates the Quicklink
process, which transfers data between your Pen and
computer. When quicklinking, you can synchronize data on
the Pen and computer or specify that data from one side is
copied onto the other. You also can designate host applica-
tions, such as Outlook or Excel so that data is exchanged
between the Pen, the Desktop and the set of host applications.

Quicklinking data is a multi-step process:

Step A. Set up communications between your Pen
and computer.

1. Make sure that the QuickLink Desktop application is
installed and running.

2. Make sure that communications have been set up
between your Pen and computer.

3. If you are using serial port communications, attach
your Pen to the computer. If you are using an external
IrDA device, make sure the device is attached to the
serial port on your computer.

Step B. Define QuickLink Settings

The QuickLink settings define for each Pen application
whether you are synchronizing your Pen and computer,
copying data from one to the other, or doing nothing.

The Desktop application contains default QuickLink
settings. You can change these settings to fit your individual
needs. If necessary, define new QuickLink settings for every
application on the Pen. If you don’t want to quicklink data
from a Pen application, choose the Don’t QuickLink the
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files of this application setting for that application.

Note: You can use the same QuickLink Desktop with more
than one QuickLink Pen. Each Pen you use is associated
with a unique Pen name on the Desktop. (See the section
Adding a Pen, page 78). You can define different
QuickLink settings for each Pen on the Desktop.

1. In the Desktop application on your computer, select
QuickLink Settings from the Pen Communications
menu (or press CTRL+Q). The QuickLink Settings
dialog box appears.

2. If the name of a Pen other than the one you are using is
displayed in the QuickLink Settings dialog box, click
on the arrow in the box next to the Pen name and select
the Pen you want from the list.

3. If you want to quicklink with host applications, click
on the This Pen will also QuickLink with host
applications checkbox. The Host Settings button
becomes enabled, allowing you to quicklink data with
host applications on your computer, such as Microsoft
Outlook, Excel and Internet Explorer. During the
QuickLink operation, the data is then exchanged
between the host application, QuickLink Desktop and
QuickLink Pen.

Note: Only one Pen can be designated at a time to
quicklink with host applications. If you have defined more
than one Pen on your Desktop, and a Pen other than the
one you are using has been selected for quicklinking with
the host applications, the Host Settings button is disabled.
To enable this button:
1. Select the Pen already designated for quicklinking with
host applications from the Pen list in the QuickLink



Settings dialog box.

2. Deselect the This Pen will also QuickLink with host
applications checkbox for that Pen.

3. Reselect the Pen with which you are working from the
Pen list, then click on the This Pen will also
QuickLink with host applications button.
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Step C. Select the Host Settings

(If you are not quicklinking with host applications, skip this step.)

1. Click on the Host Settings button in the QuickLink
Settings dialog box. The Host Settings dialog box
appears. The dialog box displays:

*  Application: A list of QuickLink Pen applications.

e Pen File: The file(s) from each Pen application
that will quicklink with the host application.

*  Host Application: The host applications for each
Pen application.

e  Host Folder: The folder in the host application
whose files will be quicklinked with the file(s)
from the Pen application or to which the files will
be transferred.

2. Double-click on the host application for the first Pen
application in the list. A list drops down of available
host applications for the Pen application.

3. Click on the host application you want to quicklink
with the Pen application, or select None.

4. Repeat the process for each application in the list.

5. When you have specified a host application for each
Pen application, click on OK.

Files quicklinked with a host application are placed in the

folder specified in the Host Folder column of the QuickLink
Settings dialog box, as well as in the QuickLink
Desktop\PenData\pen name\application folder. Pen m



application files quicklink with the host applications as follows:

e All Notes files (*.qnt) are quicklinked with the host
application.

e The Addresses in the Main Address Book file, mainadd.qad,
are quicklinked with the host application.

e The Links in the Main Internet Links file, mainlnk.qlk,
are quicklinked with the files in the specified folder of
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the host application.
* All Tables files (*.qtb) are quicklinked with the host
application.

Step D. Select QuickLink Settings for Each Application.

1. Click on the first application in the list, then click on
Change. The Change QuickLink Settings dialog box
appears. It displays the QuickLink modes that are
available for the selected application, as explained below.

2. Click on the button for the QuickLink mode you want
to select.

3. I, after copying data from the QuickLink Pen to the
computer or synchronizing data between the two, you
want files of that application type to be erased from the
Pen, click on the Flush checkbox.

4.  Click on OK.

5. Repeat for each application in the list.

Warning: Selecting Flush erases the files from your Pen.

You can select from four QuickLink modes:

Synchronize Pen and PC
The records on the Pen and computer are synchronized,
resulting in identical data files on the Pen and the computer.
If the same record was changed on both the Pen and
computer, the original records disappear and two new

m records are created—one on the Pen and one on the computer.



This mode is not available when quicklinking Notes or
Tables files.

Pen to PC

The files of the application are copied from the Pen to the
computer, overwriting the corresponding files on the
computer. If the files copied from the Pen are about to
overwrite corresponding files on the computer, the corre-
sponding files on the computer are saved as *.bak files prior
to being overwritten. The *.bak files remain in the Desktop
directory until the next QuickLink operation. This mode is
not available for Address Book or Internet Links.

PC to Pen

If you are quicklinking with host applications, the data in
the host application file overwrites the data both in the
QuickLink Desktop and on the QuickLink Pen. If you are
not quicklinking with a host application, the files on the
Desktop are copied to the Pen, overwriting the correspond-
ing files on the Pen. This mode is not available for Notes or
Tables files.

Don’t QuickLink the files of this application

No data is transmitted between the Pen and computer for the
specified application; the files remain untouched on both the
Pen and computer.

Step E. Close QuickLink Settings Dialog Box

1. If you want the QuickLink Settings dialog box to
appear before each QuickLink operation (to verify the
QuickLink options), click on the Show this Dialog
before each QuickLink checkbox prior to closing the
dialog box.

2. When you have defined the QuickLink settings for
each application, click on Close.

g
=
-

[="
o

=]

=

%]
=
|

[
=




2
3
2
[="
o
=
£
%]
=
=
5
=

Step F.  Start the QuickLink Process.

On your Pen, select QuickLink from the Main Menu.

* If communications between your QuickLink Pen and
computer fail, an error message appears. Try running the
Communications Wizard to correct the communications
setup.

o If the QuickLink Pen you have connected is not recog-
nized by the Desktop, you are prompted to use the current
Pen, choose an existing Pen or create a new Pen name.

Note: To speed up the quicklink with the host applications,
run the host applications first.

=g
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PC-Controlled Communications

The PC-Controlled Communications option in the Pen
Main Menu switches your Pen to communications mode. It
enables your computer to communicate with your Pen in

order to perform functions other than quicklinking data or
scanning from the Pen to the computer. Use it when you want to:

. Add and remove Pen components.

. Compact flash memory space on your Pen.

. Reorder the applications on your Pen.

. View information about the components on your Pen.
. Back up Pen data, applications and components.

. Restore Pen data, applications and components.

. Optimize the Pen file system

These functions are explained in the QuickLink Desktop
Functions section of this manual.

To activate the communications mode on the Pen, select
PC-Controlled Communications.
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Preferences

The Pen contains default settings for scanning and interface
languages, the menu type and other features. You can

change these default settings by selecting Preferences from
the Main Menu. Preferences contains the following options:

Scanning Language

Use this option to change the default scanning language of
the Pen.

1. Select Scanning Language.

2. Scroll to the required language and press &,

Interface Language

Use this option to change the Pen’s interface language.
1. Select Interface Language.

2. Scroll to the language you want and press .

Communications Settings

The Communications Settings option contains two sub-
options for setting up communications between your Pen
and computer: Connection Device and Baud Rate. The
Communications Wizard refers you to these settings when
you are installing the QuickLink Desktop application.

Connection Device
Use this option to specify the connection device being used
for Pen-computer communications (RS232 serial port or IrDA).
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1. Select Connection Device.
2. Scroll to the correct device and press @,

Baud Rate

Use this option to adjust the baud rate at which the Pen will

communicate with the computer so that it matches the rate

specified in the Desktop application. The default baud rate

is 115,200. If the baud rate was changed on the Desktop,

change it on the Pen, as well.

1. Select Baud Rate.

2. Scroll using ® or ® until the same baud rate that was
set on the QuickLink Desktop appears in the display.

3. Press @,

Auto Shut-Off Time

Your Pen automatically shuts off after 60 seconds if you do

not scan or press any key. The QuickLink Pen turns itself off

automatically after a given period of idle time (i.e., when it

is not being used). Use this option to adjust the automatic

shut-off time.

1. Select Auto Shut-Off Time.

2. Scroll to the automatic shut-off time you want using ®
or®.

3.  Press @,

Right-/Left-Handed
Use this option to switch between right- and left-handed
modes. Switching between these modes changes rotates the
direction of the text on the display 180°.
1. Select Right/Left-Handed .

m 2. Scroll to the mode you prefer and press @ again.
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Menu Type

Use this option to define whether your Pen menus appear as
text only, icons only, or both text and icons.

1. Select Menu Type.

2. Scroll to the menu type you prefer and press @,

Long-Press Interval

Use this option to adjust the amount of time you need to

keep a button pressed for a long press.

1. Select Long-Press Interval; the adjustment bar appears.

2. Move the slider to the setting you want, using @ or ®.

3. Test the setting by pressing and briefly holding down
the @ button. If the screen flashes, the setting is fine. If
the display does not flash, either adjust the setting to a
shorter press, or press longer.

Double-Click Interval

Use this option to adjust the amount of time between the

two clicks for a double click.

1. Select Double-Click Interval; the adjustment bar appears.

2. Move the slider to the setting you want, using @ or ®.

3. Test the setting by double clicking ®. If the display flashes,
the setting is fine. If the display does not flash, either adjust
the setting to a slower speed, or double click faster.

>

Contrast
Use this option to adjust the brightness of the display.
1. Select Contrast; the adjustment bar appears.
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“l 2. Adjust the contrast using @ or ®. The higher the
-,% number, the darker the display.

8" 3. Press @,
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=l Information

The Information option contains a number of items that
display information about your Pen. After selecting an item to
view information, press & to return to the Information menu.

Memory Status

Select this option to check how much flash memory is left on
your Pen. The Memory Status option is especially useful when
you plan to add components to your Pen and want to know
whether the flash memory card contains enough free memory.

=1

Compact Memory
Select this option to maximize free space on the Pen’s flash
memory card by compacting components on your Pen.

Battery Status

Select this option to check how much power is left in the
Pen batteries. A diagram displays the power level.

Serial Number

m Select this option to view the serial number of the Pen. When
purchasing applications, dictionaries and other components




from the WizCom on-line shop or other QuickLink Pen
application suppliers, you need to provide this serial number
for a license file to be created. The license file enables you to
use the purchased component on the Pen.

About

Select About to view information about your Pen. This
includes the version number of the Pen, copyright informa-
tion and the version number of the Pen operating system.

Advanced Pen Features

The QuickLink Pen contains three advanced features that
enable you to edit information and enter information
manually. These features are:

¢ the Editor

 the Character Bar

¢ the Opticard

Editing the Information You Have Scanned

The QuickLink Pen contains two basic modes: View Mode
and the Editor. View Mode appears when you select an
existing Address or Internet Link from the list in the View
Addresses or View Links menu. You can scroll through the
entry using ® and ® but cannot scan in new information or
make any changes. To edit the information, switch to the
Editor by pressing @».

When the Pen is in the Editor, you can edit scanned
information. The Editor exists in the Notes, Address Book,
Internet Links and Tables applications. It has two modes:
Scan Only and Edit.
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8 Scan Only Mode

_E » The field is highlighted, and the data is displayed as

é’ inverse text.

®8 * You can scan in new information with the Pen, overwrit-
& ing the existing data.

58l ©  New File dialog boxes and Tables always open in Scan
9

% Only Mode.

% * Scan Only Mode is not applicable while scanning into a
< Notes file.

» To go into Edit Mode, press @,

Edit Mode

» The data is displayed as regular text with a blinking
cursor at the beginning of the field.

*  You can edit existing information using the Edit Menu,
the Opticard or Character Bar. Or you can scan in
additional information with the Pen, inserting it at the
cursor location.

* Notes are always in Edit Mode.

When you scan in Edit Mode, the new text is highlighted. You can:

e Press @ to erase the highlighted text (i.e., so that you
can rescan it). Pressing any other key de-highlights the
text and scrolls you in the direction of the arrow, and the
text must be erased using normal editing methods.

* Scan again without pressing any buttons. The new text
is inserted at the end of the previous scan.

To exit Edit Mode and return to Scan Only Mode in Address
Book, Internet Links and Tables, press & twice.

To exit a Note and return to the Notes menu, press & twice.

Moving from Mode to Mode
Pressing @ while in an existing entry moves you from
mode to mode:



* In View Mode (Address Book and Internet Links only),

press @ to switch to the Editor. You are in Scan Only Mode.

e In Scan Only Mode (Address Book, Internet Links,
Tables), press @ to switch to Edit Mode.

Once you are in Edit Mode, you can:

*  Press @ again to access the Character Bar. The
Character Bar enables you to enter text manually, for
instance to overwrite or insert characters.

*  Press & to display the Edit Menu so that you can
perform various editing functions.

The Edit Menu and Character Bar are described in detail
later in this section.

Editing Notes

Notes are always displayed in Edit Mode. If you scan text
into an existing Note, the new text is always inserted at the
cursor location.

If the line of text you have just scanned is inaccurate and
must be rescanned, press @ while it is still highlighted to
delete it, then scan again.

If you want to edit the highlighted text, press & to access
the Edit Menu or press ®,@ or ® to de-highlight the text,
then @ to display the Character Bar. Pressing ®
de-highlights the text and enters a new paragraph.

If you are editing an existing Note (the text is not high-
lighted), press & to access the Edit Menu or press @ to
display the Character Bar.

The Notes Edit Menu contains the following commands,
which are described in detail in the Edit Commands section,
below:
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Resume Editing (to return to the Note and continue editing)
Activate Overwrite Mode (to overwrite existing text)

New Paragraph (to insert a new paragraph)

Delete Paragraph (to delete the current paragraph)

Select Language (to change the scanning language)
Scanning Options (to switch temporarily to numeric or
inverse scanning)
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Use the QuickLink Pen’s double-click feature when editing
or reviewing a Note to jump to the edge of the current
paragraph. Double-click ® or ® to jump to the first or last
line of the paragraph, respectively; double-click @ to jump
to the left edge or ® to jump to the right edge of the current line.

Editing Addresses

Scan Only Mode is the default when you are entering a file

name or scanning in a new Address. If you open an existing

Address directly through the View Addresses menu, it

appears in View Only Mode.

If an entry is in View Mode:

e Press @ to switch to the Editor. The entry is in Scan
Only Mode.

e Press @ again to go into Edit Mode.

*  Once in Edit Mode, if you want to edit the existing
Address, press & to access the Edit Menu or press @
to display the Character Bar.

Alternatively, to open an existing Address directly in the
Editor:
1. Select View Addresses.
2. Scroll to the Address you want to view.
3. Press @. The Addresses Menu appears.
m 4. Select Edit Addresses. The Address appears in Scan
Only Mode.



The Address Book Edit Menu contains the following
commands, which are described in detail in the Edit
Commands section, below:

Resume Editing (to return to the Address and continue
editing)

Activate Overwrite Mode (to overwrite existing text)
Insert Line (to add another line to a field)

Delete Line (to delete a line from a field)

Clear Line (to delete the contents of a line)

Scanning Options (to switch temporarily to numeric,
inverse or multiple-line scanning)

Use the QuickLink Pen’s double-click feature when you are
editing an Address to jump to the edge of the current field.
Double-click @ to jump to the beginning of the field, or ®
to jump to the end.

Editing Internet Links

Scan Only Mode is the default when you are entering a file
name or scanning in a new Link. If you open an existing
Link directly through the View Links menu, it appears in
View Only Mode.

If an entry is in View Mode:

e Press @ to switch to the Editor. The entry is in Scan
Only Mode.

*  Press @ again to go into Edit Mode.

e Once in Edit Mode, if you want to edit the existing
Link, press @ to access the Edit Menu or press @ to
display the Character Bar.

Alternatively, to open an existing Link directly in the Editor:
1. Select View Links.
2. Scroll to the Link you want to view.
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3. Press @. The Links Menu appears.
4. Select Edit Link. The Link appears in Scan Only Mode.

The Internet Links Edit Menu contains the following
commands, which are described in detail in the Edit
Commands section, below.
Resume Editing (to return to the Link and continue editing)
Activate Overwrite Mode (to overwrite existing text)
Insert Line (to add another line to a field)
Delete Line (to delete a line from a field)
Clear Line (to delete the contents of a line)
Scanning Options (to switch temporarily to numeric,
inverse or multiple-line scanning)

Use the QuickLink Pen’s double-click feature when you are
editing an Internet Link to jump to the edge of the current
field. Double-click @ to jump to the beginning of the field,
or ® to jump to the end.

Editing Tables

Scan Only Mode is the default when you enter a file name,
scan in a new Table or open an existing one. To edit
information in the Table, press @ to go into Edit Mode.
Press @ again to display the Character Bar or press & to
display the Edit Menu. Or you can scan in additional
information with the Pen, inserting it at the cursor location.

While in Edit Mode:

*  You can edit only one cell at a time.

¢ You can scroll from line to line within a cell, but not
from cell to cell. To scroll from cell to cell, first press &
twice to return to Scan Only Mode.

To edit an existing Table:
1. Open the Table you want to edit.



Scroll to the cell you want to edit using ®, ®, © or ®,
then press @ to go into Edit Mode.

Use @ and ® to scroll to where you want to edit data.
If the cell contains more than one line, use ® and ® to
scroll to the line you want to edit.

Press & to open the Edit Menu or @ to display the
Character Bar.

When you have finished editing the cell, press & twice
to return to Scan Only Mode.

Scroll to the next cell you want to edit and repeat the
process.

The Tables Edit Menu contains the following commands,
which are described in detail in the Edit Commands section,
below:

Resume Editing (to return to the Table and continue
editing)

Activate Overwrite Mode (to overwrite existing text)
Clear Line (to delete the contents of a line)

Select Language (to change the scanning language)
Scanning Options (to switch temporarily to numeric,
inverse or multiple-line scanning)

Insert Row (to insert a row)

Insert Column (to insert a column)

Remove Row (to remove a row)

Remove Column (to remove a column)

Insert Line (to add another line to a cell)

Delete Line (to delete a line from a cell)

Use the QuickLink Pen’s double-click feature when you are
editing a Table to jump to the edge of the current cell.
Double-click @ to jump to the beginning of the cell, or ® to
jump to the end.
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Editing Commands

The Edit Menu contains a list of commands that enable you
to perform various editing functions within the selected
application.

To display the Edit Menu, press &, To exit the Edit Menu,
press & again.

Note: You must be in Edit Mode in order to access the
Edit Menu.

The Edit Menu contains the following commands, listed in
alphabetical order:

Activate Overwrite Mode

(Notes, Address Book, Internet Links, Tables)

This command enables you to toggle to Overwrite Mode in
order to overwrite existing text. The Activate Overwrite
Mode option changes to Activate Insert Mode when it is
selected.

When the Pen is in Insert Mode, the cursor appears as a
blinking cursor between two characters. If you add a
character or characters using the Opticard or Character Bar,
they are inserted after the cursor location.

When the Pen is in Overwrite Mode, the current character is
highlighted. Adding a character or characters using the
Opticard or Character Bar overwrites the text starting at the
highlighted character.

Clear Line

(Address Book, Internet Links, Tables)

Use this command to delete the contents of a field:
1. Scroll to the line you want to clear.



2. Press @ to switch to Edit Mode, then press & to open
the Edit Menu.

3. Select Clear Line.

If the field or cell contains multiple lines, the other lines

remain unchanged.

Delete Line

(Address Book, Internet Links, Tables )

Use this command to delete a single line of information
from a field or cell.

1. Scroll to the line in the field you want to delete.

2. Press @ to switch to Edit Mode, then press & to open
the Edit Menu.

3. Select Delete Line.

Delete Paragraph
(Notes only)
Use this command to delete a paragraph of text.

1. Place the cursor on the paragraph you want to delete.
2. Press & to open the Edit Menu.
3. Select Delete Paragraph.

Insert Column

(Tables only)

Use this command to add a column to a table. The column is
inserted before the current column.

1. While still in Scan Only Mode, scroll to where you
want to add a column.

2. Press @ to switch to Edit Mode and open the Edit
Menu.

3. Select Insert Column. The column is inserted to the
left of the current column (for left-to-right Tables).

n
5]
=
=
=
I}
)
=
=
)
=¥
=
D
]
=
<
>
=
<




Insert Line

(Address Book, Internet Links, Tables)

Use this command to insert an additional line of information

in a field or cell:

1. Scroll to the field or cell where you want to add a line
of information.

2. Press ® to switch to Edit Mode, then press & to open
the Edit Menu.

3. Select Insert Line. The new line appears above the
current line. You can now scan in the new text.
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Note: To add a line at the end of a cell when the Multiple
Lines option is activated for a Table, scroll to the last line
in the cell and press .

Insert Row

(Tables only)

Use this command to add a row to a Table. The row is

inserted above the current row.

1. While still in Scan Only Mode, scroll to where you
want to add a row.

2. Press ® to switch to Edit Mode and open the Edit
Menu.

3. Select Insert Row.

New Paragraph

(Notes only)

This command enables you to insert a new paragraph of text
between two paragraphs.

1. Place the cursor on the paragraph you want the new

m paragraph to follow.
2. Press ® to open the Edit Menu.



3. Select New Paragraph. The new paragraph is inserted
after the selected paragraph.

Remove Column

(Tables only)

Use this command to remove a column from a table.

1. While still in Scan Only Mode, scroll to the column
you want to delete.

2. Press @ to switch to Edit Mode and open the Edit
Menu.

3. Select Remove Column.

4. When the confirmation appears, select Yes.
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Remove Row

(Tables only)

Use this command to remove a row from a Table.

1. While still in Scan Only Mode, scroll to the row you
want to delete.

2. Press @ to switch to Edit Mode and open the Edit
Menu.

3. Select Remove Row.

4. When the confirmation appears, select Yes.

Resume Editing

(Notes, Address Book, Internet Links, Tables)

Select this command to exit the Edit Menu and return to the
entry to resume editing.

Scanning Options

(Notes, Address Book, Internet Links, Tables, Scan to PC)
Scanning options enable you to specify temporary settings

for a specific field or word in the Notes, Address Book,

Internet Links, Tables and Scan to PC applications. They are m
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useful when you are scanning:
* in a different language
* numbers only
* light text on a dark background
* multiple lines of text.

To display scanning options when in Scan Only Mode in the
Address Book or Internet Links application, press @ from
the field you want to scan.

To display scanning options while in Edit Mode:
1. Press ® to open the Edit Menu.
2. Select Scanning Options.

To toggle a scanning option on or off, press @, @ or ®;

= on. You can select a single option or all options,
depending on what you are scanning. The scanning options
return to the default when you exit the field. Scanning
options are:

Numeric
If you are scanning a string of numbers, select this option so
that the Pen knows to read all characters as numbers.

Inverse
If you are scanning light text on a dark background, select
this option.

Multiple Lines

Select this option if you want to scan more than one line of
text into a field or cell. It is the default setting for the
Address and Notes fields in the Address Book. This option
in not available for a new file name or in Notes.

To use the Multiple Lines option while scanning into a cell
in a Table:



1. Scan the information into the first line in the cell.

2. Press @ to switch to Edit Mode.

3. Press & to open the Edit Menu and select Scanning
Options.

4.  Select Multiple Lines, then press & to return to the
cell. The multiple lines prompt appears at the upper
right of the cell to tell you how many lines are in the
cell and which is the current line.

5. Press @ to add another line to the cell below the first
line. (To insert lines before an existing line, use the
Insert Line command).

6. Press & to return to Scan Only Mode.

Select Language

(Notes, Tables, Scan to PC)

If the material you are scanning is in a language other than
the current default scanning language, use this command to
select the correct language.

To select a scanning language:
1. Select Select Language. The current language is displayed.
2. Select the language you want.

Note: You cannot change the scanning language if text
already exists in the selected field. The application first
asks you to delete the existing text.

The Character Bar

The Character Bar enables you to enter text manually. Use it
to overwrite or insert characters. The Character Bar can be
activated only in Edit Mode. To activate it, press @.

If the Pen is in Scan Only Mode of the Editor, you must
press @ to switch to Edit Mode and then press @ again to
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activate the Character Bar. The Character Bar operates in
either Insert Mode or Overwrite Mode, according to the
setting in the Edit Menu.

Bar. The ChBaracter

Bar contaims a series of

170]
o
=
=
N
]
>
=
=}
5}
="
=
5}
o
=]
<
>
=
<

The Character Bar

The Character Bar contains the default character set (in
lower case) and the following buttons:

Punctuation

If you scroll to the Punctuation button and press @, it
becomes the active sequence and a series of punctuation
marks is displayed.

Numbers
If you scroll to the Numbers button and press @, it becomes
the active sequence and numbers 0-9 are displayed.

Alphabet
If you scroll to the Numbers or Punctuation button and press
@D, it becomes the active sequence and the Alphabet button
(displayed in Latin characters or the relevant default

m alphabet) appears instead. To reselect the alphabet as the
active sequence, scroll to the Alphabet button and press @D,



[#]

Multiple Characters

When the Multiple Characters button appears, you can enter
more than one character at a time. Multiple characters is the
default mode.

Single Character

If you scroll to the Multiple Characters button and press @,
it toggles to the Single Character button and you can enter
only one character at a time using the Character Bar.

Delete
The Delete button enables you to delete characters (see
below for instructions).

Note: If you are in Insert Mode in a field (e.g., a file
name) with a limited number of characters, and you
access the Character Bar while the Pen is in Insert Mode,
the cursor jumps immediately to the Delete button. It
won't move from the Delete button until you delete a
character from the field. If you delete all characters in the
field, the Character Bar disappears automatically.

In addition, the end of the alphabet sequence contains the
following symbol:
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Insert Space

If you scroll to the Insert Space symbol and press @, it
enters a space in the text string or overwrites a character
with a space.
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Using the Character Bar

To enter multiple characters:

1. Scroll to the location in the field where you want to
insert or overwrite a character.

2. Press @ to switch to Edit Mode (if you are in Scan
Only mode), then press @ again to activate the
Character Bar.

3. Scroll to the first character you need in the Character
Bar and press @,

4. Repeat Step 3 for each character you are entering.

To enter one character at a time:

1. Scroll to the location in the field where you want to
enter a character.

2. Press @ to switch to Edit Mode, then press @ again to
activate the Character Bar.

3. Scroll to the Multiple Characters button and press .
The Character Bar toggles to Single Character Mode. It
remains in this mode until you scroll to the Single
Character button and press @ to reactivate the
Multiple Characters button.

4.  Scroll to the required character in the Character Bar.

5.  Press @, The new character is entered at the cursor
location.

To enter a variation of a character (e.g. in upper case or with

m an accent added):



3,
4.

Scroll to the letter in the Character Bar.

Press ® or ®. The Character Bar is replaced by a list
of variations for the selected letter. Pressing ® places
the cursor on the upper case variation (see below);
pressing ® places the cursor on the lower case
variation.

adai5AafAAARARA
Scroll to the variation you want using @ or ®.
Press @D,

Note: To toggle out of the sequence for the selected letter
without making a selection, press ® or ® again.

To delete a character or characters:

1.

Scroll to the character you want to delete. If the Pen is
in Insert Mode, the cursor is positioned before the
character. If the Pen is in Overwrite Mode, the
character is highlighted.

Press @ to activate the Character Bar.

Make sure you are in Multiple Characters Mode if you
want to delete more than one character.

Scroll to the delete button and press &,

If you are deleting more than one character, press @
for each character in the sequence that you want to
delete.

To select a different character set from the Character Bar:

1.

Scroll to the required button (e.g., numbers or
punctuation).

Press @,

The selected character set becomes the active one.
Select a character in the same manner as above.
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If you switch your Pen to a language that uses non-Latin
characters (e.g., Hebrew, Greek, Russian, etc.), the Charac-
ter Bar displays a sixth button when activated. The current
alphabet becomes the active character sequence and the
additional button is for the Latin alphabet, which is selected
in the same manner as numbers and punctuation.

Using the Opticard

Some words and phrases can’t be scanned because the
letters are too large, are handwritten or are on a type of
background that the Pen cannot scan. The Opticard, located
on the back of your Pen case, enables you to enter these
words or phrases manually by scanning in letters one at a
time using the bar codes.

You can also use the Opticard to enter and edit information
in fields such as Enter file name, First name, etc.

To use the Opticard:

1. Holding Pen case horizontally, with the Opticard title
on the right, scan the Opticard key on the Opticard to
activate the Opticard Mode. When Opticard Mode is
activated, the light in the tip blinks rapidly.

2. To enter a letter, scan the bar code for the correspond-
ing key. The letter appears on the display.
¢ To enter a lower-case character (below bar code),

scan only the letter.

»  To enter an upper-case character (left, above bar
code), scan Shift, then the letter.

*  Scan Shift twice to activate/deactivate the Caps
Lock. Activating the Caps Lock enables you to
enter letters in upper case only.

. To enter a controlled character (right, above the
bar code), scan Ctrl, then the letter. Controlled



characters can be entered only for the active
character set.

o To enter a controlled character (right, above the
bar code) in upper case, scan Ctrl, then Shift (or
Shift, then Ctrl), then the letter.

To enter a space, place the cursor in front of the letter

that will follow the space, then scan the spc key.

To delete the previous character, scan Shift, then the

del key.

Continue scanning in letters as required.

When you are finished, scan the Opticard key to

return to normal scanning. The application is in Edit

Mode.
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Note: If you want to change the scanning language prior

to entering information into a cell in a Table or a new

paragraph of a Note using the Opticard:

1. If the Opticard is not already activated, scan the
Opticard key.

2. Scan the Lang. key. The language menu pops up.

Select the required language from the menu.

4. The Pen is still in Opticard Mode; enter the
information as usual.
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Part 3: The QuickLink
Desktop Application

Introduction to QuickLink Desktop

The QuickLink Desktop application enables you to ex-
change data between the QuickLink Pen and your computer.
This exchange of information is known as quicklinking.
Using the Desktop, you also can attach your Pen to the
computer and use it as a scanner to enter data directly.

The Desktop application enables you to perform a variety of
other functions related to your Pen. For instance, you can
customize the Pen by adding and removing components. This
includes adding components such as applications, dictionaries,
additional character sets (e.g., Cyrillic, Japanese, etc.) and OCR
spellers from the QuickLink CD or the WizCom web site’s on-
line shop. You also can download applications from other
software vendor sites on the web and add them to your Pen.

In addition, the Desktop enables you to upgrade your Pen’s
operating system, backup and restore data, applications and
components, and perform several other Pen management
functions. It also contains functions for editing Pen data
directly on your computer.

Desktop Components
Before using the Desktop, it’s a good idea to familiarize
yourself with its components. The Desktop is divided into
four major areas. They are:

*  Menu bar

e Toolbar

Desktop window
e Status bar



In addition, the task tray in the Windows taskbar contains
the Desktop status indicator icon.

Title bar )
B

Menubar— 1) 3 |l ) # @i ome ST

Toolbar —— £ RomLept || e 8 S curmie Ties pa fe
fiw. Thin file v crested dire

Application —| o Db op

pane

Files pane —— —

Current file

pane

Inderved Lirdg
QuickLink Desktop Window
Menu Bar

The menu bar displays the menus containing options for
operating the Desktop functions. These menus are described
briefly below.

To select an option, click on the menu, then click on the
option in the drop-down list.

Some menu options can be activated by executing a series
of key strokes known as a short-cut key command. If the
option contains a short-cut key command, the command is
displayed to the right of the option. To execute the key
command, press the sequence of keys.

For example, to view the QuickLink log, press CTRL+G.
This means to depress CTrL, hold it down and press G.
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File

The File menu contains options for managing files in the
current application (e.g., Notes, Address Book, Internet
Links or Tables). You can create a new file or open an
existing file; save the current file under a different name or
type or in a different location; find a text string in a file, or
print the current file. In addition, the Pens dialog box is
accessed through the File menu. This dialog box contains
options for adding, renaming and removing QuickLink Pens.
The Exit command in this menu closes the Desktop application.

Pen Communications

This menu contains options for turning communications
with the QuickLink Pen off or on; adding and removing Pen
components: backing up and restoring your Pen data,
applications and components; optimizing the file system on
the QuickLink Pen; changing the communications settings
on the Desktop; and defining QuickLink and Scan to PC
settings.

View

Use the View menu options to view the QuickLink log
(which contains a history of the last three communications
sessions), change the Desktop interface language (not
available in all versions), change the text size in the Desktop
window, toggle the toolbar and status bar on and off, or
select an application.

Help

The Help menu enables you to access on-line Help (which
provides you with complete instructions for operating the
Desktop), register the QuickLink Desktop via the WizCom
web site and view version and copyright information. In
addition, if you need to set up or troubleshoot communica-



tions between your QuickLink Pen and PC, you can run the
Communications Wizard from this menu.

Toolbar

Located beneath the menu bar is a series of buttons known
as the toolbar. These buttons allow fast access to some of
the menu options. To select a toolbar option, click on the

button. If you place the mouse cursor on the button, a tooltip

pops up that displays the button’s name. Buttons are:

New - Creates a new file in the selected
application.

Open - Opens a file in the selected application.

Save As - Saves the current file under a new
name or in a different format.

Print - Prints the current file.

Pens - Enables you to add, rename or remove
Pens from the Desktop.

Add/Remove Pen Components - Enables you
to add or remove QuickLink Pen components.

R RN @ =D

Turn Pen Communications Off/On - Toggles
communications with the QuickLink Pen off and on.

¥
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Current Pen - Specifies the Pen
selected on the Desktop.

[

Help - Accesses Desktop Help.
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Desktop Window

The Desktop window contains two or three vertical panes:
two for Address Book and Internet Links, and three for
Notes and Tables. The left pane displays the applications
installed on the current Pen. If Notes or Tables is selected,
the middle pane displays a list of files. The right pane
displays the current file for all applications and is the area in
which you view and edit data.

To resize or hide a pane, drag the split bar between two
panes to one side.

Application Pane
The application pane displays the QuickLink Pen applications.

To select an application, click on the application icon. (Or,
select the application from the View menu.) The current
application is displayed in the title bar of the Desktop window.

Files Pane

When you select the Notes or Tables application, the center
pane appears. This pane displays the list of files for the
application. Click on a file to open it. The file opens in the
Current File Pane.

Current File Pane

The Current File Pane displays the current file. The name of
this file is displayed in the title bar along with the selected
application.

To open a file, select Open from the toolbar or File menu,
then select a new file from the list in the Open dialog box.
Or, (for Notes or Tables) click on a different file in the Files
pane. Only one file can be opened at a time.



The current file pane is the editing area for the current file.
Each line on the screen is a record or paragraph in the
current file. Every item of information in the record (with
the exception of Notes) is a field.

To edit, add or delete records in this pane in the Notes,
Addresses or Internet Links application:

1. Select the record, then right-click to access the pop-up

menu and select Edit. Or, double-click on the field to
activate Edit Mode.

2. Next, edit the record using common Windows key-
board edit commands.

To edit cells in this pane in the Tables application:

1. Click once on the cell to activate Overwrite Mode.

2. Edit the cell using common Windows keyboard edit
commands.

To add or remove a column or row:

1. Right-click on the column head or row number. The
pop-up menu appears.

2. Select the relevant option.

Note: Whenever you make changes to a file, they are
saved automatically.

Status Indicator Icon @

QuickLink Desktop also features a status indicator icon,
located in the task tray on the right side of the Windows
taskbar at the bottom of the screen. If, during QuickLink
Desktop installation, you specified that the Desktop

launches on startup, the icon appears automatically each

time you start up your computer. Otherwise, it appears only

when you run Desktop.
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This icon enables you to execute the most common Desktop
commands while working in a host application—without
having to open the Desktop application. To access these
options, click on the icon and choose from the following
options in the pop-up menu:

Hide/Show Window — Enables you to hide or display
the Desktop application.

Turn Pen Communications On/Off — Enables/disables
communications between the Desktop and the
QuickLink Pen.

QuickLink Settings — Displays the QuickLink Settings
dialog box so that you can define the QuickLink settings.
Scan to PC Settings — Displays the Scan to PC Settings
dialog box so that you can define the character to be
inserted after each line of text you scan.

Log — Displays the QuickLink log.

QuickLink Desktop Help — Displays Desktop on-line
Help.

About QuickLink Desktop — Displays the current
version of Desktop.

Exit — Exits the Desktop application.
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Changing the Desktop Interface Language

Multilingual versions of QuickLink Desktop allow you to
change the language of the user interface. If the new
interface language is available for the Help files and the Pen
application resources on the Desktop, these also change
when you select the new language.

To change the interface language:
1. Select Interface Language from the View menu. The
-
Interface Language dialog box appears.



2. Select the interface language you want from the list,
then click on OK.
3. Restart QuickLink Desktop.

If your Desktop contains additional interface languages,
they appear in the list in the Interface Language dialog box.
To add languages to this list, check your CD-ROM installa-
tion. If you did not install all the language modules from
your CD-ROM, you can install them later on using the
installation program.

Note: If the version of Windows you are using doesn’t
support the character set of the language you have selected,
you will not be able to see the character set correctly.

Changing Text Size in the Desktop

The Text Size option in the View menu enables you to

change the text size in the Files and Current File panes. To

change the text size:

1. Select Text Size from the View menu.

2. Click on the text size you want: small, medium or
large.

On-line Help

QuickLink Desktop on-line Help contains complete
instructions for using the Desktop application. Search the
Help files using the index or table of contents.

To access on-line Help:

* Select QuickLink Desktop Help from the Help menu
or the status indicator icon menu, or

* Click on the Help icon in the Toolbar, or

e Press Fl
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QuickLink Desktop Functions

Managing Pens on the Desktop

You can use more than one QuickLink Pen with the same
QuickLink Desktop application. Each QuickLink Pen is
defined on the Desktop by a unique name so that the
software will recognize it. This enables communications
between your QuickLink Pen and computer so that you can
quicklink data between the two or perform other Pen-
computer communications.
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The Pens dialog box contains several options for managing
the Pens on your Desktop. Use it to add, rename or remove
a Pen or set the current Pen. To open the Pens dialog box,
select Pens from the File menu or the toolbar (or press
CtrL+E).

Adding a Pen

When you install QuickLink Desktop, it automatically
assigns the name “MyPen” to the first Pen on the Desktop.
You can add other Pens to the Desktop application so that
you can manage all your Pens on one computer. Ideally, you
should create a Pen on the Desktop for each QuickLink Pen
you own. You are advised to create only one name for each
QuickLink Pen.

To add a Pen:

1. Open the Pens dialog box.

2. Select Add. The Add Pen dialog box appears.

3. Type in a name for your Pen and click on OK. If the
name already exists, a message appears and you are
asked to enter a different name.

4. Click on OK.



Renaming a Pen
You can assign a different name to “MyPen” or any other
Pen on the Desktop. To rename a Pen:

1. Open the Pens dialog box.

2. Select the Pen you want to rename.

3. Select Rename. The Rename Pen dialog box appears.

4. Type the new name into the prompt and click on OK.
If the name already exists, a message appears and you
are asked to enter a different name.

5. Click on OK.

Removing a Pen
You can remove a Pen from the Desktop. When you do so, all
data for the Pen is erased from the Desktop. To remove a Pen:

Open the Pens dialog box.

Select the Pen you want to remove.

Select Remove.

When the confirmation appears, select Yes.
Click on OK.

Nk L=

Setting the Current Pen

The current Pen is the Pen which is displayed in the Current
Pen box on the toolbar, and the data for this Pen is displayed
in the Desktop window.

You can change the current Pen at any time by selecting a
different Pen from the Current Pen drop-down list in the
toolbar. Alternatively, you can:

Open the Pens dialog box.

Select the Pen that you want to make current.
Click on Set as Current.

Click on OK.
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Communicating Between the Pen and
Computer

QuickLink Desktop gives you the option of working on- or
offline. When you are working online, communications with
the QuickLink Pen are enabled. The Desktop occupies the
serial port on your computer and is in a state of readiness to
receive communications from the QuickLink Pen. It detects
the quicklink or Scan to PC being sent from the QuickLink
Pen, and can also initiate Desktop-controlled communica-
tions, such as adding and removing Pen components. This is
the default mode.

When the computer is offline, communications with the
QuickLink Pen are disabled. The Desktop cannot detect
communications from, nor initiate communications with,
the QuickLink Pen. The Pen Communications menu
options are disabled.

To toggle Pen communications off, select Turn Pen
Communications Off from the Pen Communications
menu, the toolbar or the status indicator icon menu (or press
F2). The option toggles to Turn Pen Communications On.
Select Turn Pen Communications On to toggle Pen
communications back on.

Note: When Pen communications are enabled, the serial
port you specified in the communications settings on the
Desktop is busy, and you will be unable to use the port for
any other purpose.

Communications Settings
The communications settings define the type of communica-
tions you are using—serial port or infrared, the serial port



on the computer to which the QuickLink communications
cable or IrDA device is connected, and the baud rate (the
speed at which the data is transmitted) or type of IR driver.

Communications settings must be defined on both the
QuickLink Pen and Desktop. If you have successfully run
the Communications Wizard, the communications settings
are defined correctly. You can run the wizard during
installation or later on. If you change the communications
type (serial port or infrared), the IR driver, or the baud rate,
you need to redefine communications settings on both the
Desktop and Pen.
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To change communications settings on the Desktop:

1. Select Communications Settings from the Pen
Communications menu. The Communications
Settings dialog box appears.

2. To change the serial port to which the QuickLink
communications cable or external infrared device is
connected, or with which the internal infrared device is
associated, click on the arrow on the Serial Port box
and select the serial port you are using from the drop-
down list.

3. The default communications baud rate is 115,200. To
change the speed at which data will be transmitted for
serial port communications, click on the arrow next to
the Baud Rate box and select the baud rate from the
drop-down list.

4. To change the settings from serial port to IrDA
communications, click on the IrDA communications
checkbox. Next, click on the arrow next to the IR
Driver box and select the correct driver from the list. m

5. Click on OK.



Note: The communications settings must be the same on
the QuickLink Pen and the computer.

To run the Communications Wizard, select Communica-
tions Wizard from the Help menu.

Adding and Removing Pen Components

You can customize your QuickLink Pen by adding and
removing components. The available component types are:
*  Applications (software programs for your Pen)
*  Dictionaries (dictionaries to be used on the Pen)
*  OCR languages (to enable optical character
recognition in multiple languages)
*  Interface languages (menu languages)
*  Viewing languages (to enable your Pen to display
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text in a specific language)
*  Software modules (resources required by the Pen
applications)
*  Systems (components required for the correct
operation of the Pen)
*  Others (miscellaneous component types)
The QuickLink CD-ROM included with your QuickLink Pen
contains a folder (QuickLink Desktop Installation\Library
of Pen Components) that includes a library of applications,
and OCR, viewing and interface languages, as well as a
backup copy of the components already on your Pen. Many
other components, including dictionaries, are available from
the on-line shop on the WizCom web site. In addition, you
can download components for your Pen from other Internet
software providers.

Adding and Removing Components

Adding and removing components is a multi-step process:



Step A. Set up communications between Your Pen
and computer.
1. Turn your Pen on and connect it to your computer.
2. Select PC-Controlled Communications from the
QuickLink Pen Main Menu.
3. Make sure that Pen communications are on on your
computer.

Step B. Open the Add/Remove Pen Components
Dialog Box

In the Desktop, select Add/Remove Pen Components from

the Pen Communications menu or the toolbar (or press

CtrL+A). The Add/Remove Pen Components dialog box

appears.

If communications between your QuickLink Pen and
computer fail, an error message appears when you select
Add/Remove Pen Components. Try running the Commu-
nications Wizard to correct the communications setup.

If the QuickLink Pen you have connected is not recognized
by the Desktop, you are prompted to use the current Pen,
choose an existing Pen or create a new Pen name.

The Add/Remove Pen Components dialog box contains two
lists for managing the components you are adding to or
removing from the Pen:

Left List: Available Components

The left list displays everything in the QuickLink Desktop
Pen Components folder on your computer’s hard drive. If
you have downloaded applications, dictionaries or other
components from the Internet or from the QuickLink CD-
ROM to the Pen Components folder, they are displayed in
this list.
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To quickly find which components you want to add to the
QuickLink Pen, click on the Hide components already on
Pen checkbox. Only components not yet installed on your
QuickLink Pen, or upgrade versions of existing components
on your Pen, appear in the left list.

Right List: Components on Pen

The right list displays all components currently on your
QuickLink Pen, as well as all components you have selected
to add. It also indicates whether a component has been
marked for deletion, as described below. The icon next to
each component indicates the component’s location. If the
component is already on the Pen, the icon indicates whether
it is in the flash memory or ROM. When the icon indicates
that the component is still located on your computer’s hard
drive, it has yet to be added to the Pen.

To view information about a component in either list, right-
click on the component. To view information about all
components currently on the QuickLink Pen, click on the
Details button.

Step C. Filter the Components that Appear in the
Lists (Optional)

1. To select the types of components that appear in either
list, click on the Filters button. A list of component
types appears.

2. Click on the checkbox next to each type to select/
deselect it; W= component is selected.

Step D. Order the Components in the Lists (Optional)
You can order the components in either list by name,
version, type, size or protected by clicking on the respective
column heading.



Step E. Select the Components To Add to the Pen

1. In the left list, click on each component that you want
to add to the QuickLink Pen. The component is
highlighted. To highlight more than one component,
hold down the CtrL key, then click on each item you
want to add. To highlight a group of components that
are next to each other, hold down the Shirt key and
click on the first component in the group, then on the
last one.

2. Click on = ;the highlighted components appear in the
right list.

3. If] after selecting a component, you decide you don’t
want to add it:

*  Click on the component in the right list. The
component is highlighted.

e Click on < . The component is removed from the
right list.

4. If a component you selected to add to the Pen already
exists on the Pen, the existing component of the same
type is marked automatically for deletion: Ared ‘X’
appears over its icon. Deselect the duplicate component.
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Step F.  Select Components To Delete from the Pen

1. In the right list, click on each component that you want
to delete. The component is highlighted.

2. Click on Delete. A red ‘X’ appears on the icon of each
component you marked for deletion.

3. If you change your mind about deleting a component,
click on the component in the right list, then click on
Undelete.

System components should be deleted from your QuickLink

Pen only if you are adding a new version of the component

to the Pen at the same time. Otherwise, your Pen will not

operate properly. m



Note: You cannot delete your QuickLink Pen’s operating
system or a component from your Pen’s ROM.

Step G. Proceed

1. Click on the Proceed button.

2. To stop the Add/Remove Pen Components process
prior to completion, click on Stop. When the process
is completed, the Stop button changes to OK.

Step H. Close the Log Window
Click on OK to close the Add/Remove Pen Components
Log Messages window once the process is completed.
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Stepl. Compact Your Pen (Optional)

If you removed components from your QuickLink Pen, you
may want to compact the Pen at this time. To do so, click on
Compact. The compaction process is explained in detail below.

Step J. Exit the Dialog Box
Click on Exit to close the Add/Remove Pen Components
dialog box.

Note: Any application you add to your QuickLink Pen
appears as an additional option in the Pen Main Menu.

Restoring Components to Your QuickLink

Pen from the CD-ROM

The CD-ROM that comes with the QuickLink Pen contains
a backup copy of the components included on the Pen. You
can use the backup copy to restore components to your Pen;
however, you first must copy the components to the
QuickLink Desktop Pen Components folder. To do so:

m 1. Insert the QuickLink CD-ROM into the CD drive on
your computer. If the setup does not begin automatically:



e Click on the Windows Start button and select Run.
*  Type x:\setup.exe (where x is your CD-ROM
drive), then click on OK.

2. Click on browse cd rom contents.

3. Double-click on QuickLink Desktop Installation,
then double-click on Library of Pen Components.

4. Select the components you want to copy, then press
Crre+C.

5. Open the Pen Components folder under the Desktop
installation folder on your computer’s hard drive
(usually located at c:\Program Files\QuickLink
Desktop\Pen Components).

6. Press CTRL+V to paste the components into the Pen
Components directory.
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Once the components have been copied to the Pen Compo-
nents folder on the computer hard drive, follow the instruc-
tions above for adding and removing Pen components in
order to restore the components to your Pen. The compo-
nents you copied into the Pen Components folder appear in
the left window of the Add/Remove Pen Components dialog
box.

Upgrading Your Pen’s Operating System

You can upgrade your QuickLink Pen’s operating system

using the Add/Remove Pen Components dialog box. To do so:

1. Follow the steps for adding and removing components,
as described above.

2. Select the new operating system from the left list in the
Add/Remove Pen Components dialog box to add to the Pen.

3. Click on Proceed.

The Add/Remove Pen Components Log Messages window
displays each step in the upgrade process. The Stop button

87



in this window is disabled during the upgrade process. Do
NOT attempt to stop the process prior to its completion.

As part of the upgrade process, the Pen restarts itself.

Compacting Your Pen

The Current flash memory status bar in the Add/Remove

Pen Components dialog box displays the allocation of space

on the flash memory:

* Unavailable — This area of the flash memory is
unavailable for use by Pen components.

* Used - This area is being used by Pen components.

* Compactible — This area contains Pen components that
have been deleted from your Pen, which can be erased
to free up space.

*  Free — This area contains unused flash memory.

» Total — The total flash memory on your Pen.
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The Compact button in the Add/Remove Pen Components
dialog box enables you to reclaim the compactible areas on
the Pen’s flash memory.

You QuickLink Pen is compacted automatically during the
Add/Remove Pen Components process. To compact your
QuickLink Pen when you are not adding and removing Pen
components:

1. Turn your Pen on and select PC-Controlled Commu-
nications from the Pen Main Menu.

2. In the Desktop, select Add/Remove Pen Components
from the Pen Communications menu or the toolbar
(or press CTrL+A). The Add/Remove Pen Components
dialog box appears.

- 3. Click on Compact. A bar appears on the Pen that
88 displays the progress of the compaction process. When



the process is completed, the compactible area is
converted into free area on the Pen.
4. Click on Exit.

Reordering the Applications on Your Pen
The App Order button in the Add/Remove Components
dialog box enables you to change the order in which the
applications appear on your QuickLink Pen. You can reorder
the applications prior to closing the Add/Remove Pen
Components dialog box after adding and removing compo-
nents, or at any other time.
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To reorder the applications:

1. Turn your Pen on and select PC-Controlled Commu-
nications from the Pen Main Menu.

2. In the Desktop, select Add/Remove Pen Components
from the Pen Communications menu or the toolbar
(or press CTRL+A).

3. Select App Order. The Applications Order dialog box
appears.

4. To move an application to a different place in the list,
click on the application, then click on Up to move it up
in the list or Down to move it down in the list.

5. When applications are ordered as you prefer, click on OK.

6. Click on Exit to close the Add/Remove Pen Compo-
nents dialog box.

Backing Up and Restoring Pen Data,
Applications and Components

The Backup Pen and Restore Pen options enable you to

create a backup copy (*.bak file) of your QuickLink Pen

data, applications and components on the computer, which

can later be restored to your Pen. E



Backup Pen

To back up your QuickLink Pen data, applications, and

components:

1. Turn your Pen on and select PC-Controlled Commu-
nications from the Pen Main Menu.

2. Select Backup Pen from the Pen Communications
menu (or press CTRL+B). The Save As dialog box appears.
¢ If communications between your QuickLink Pen

and computer fail, an error message appears when
you select Backup Pen. Try running the Commu-
nications Wizard to correct the communications
setup.

e If the QuickLink Pen you have connected is not
recognized by the Desktop, you are prompted to
use the current Pen, choose an existing Pen or
create a new Pen name.

3. Type the name of the backup file into the File name field.

4. To save the file in a different folder, open the Save in
box and double-click on a different folder in the folder list.

5. Click on Save.

When the confirmation message appears, click on Yes.

7. Click on OK.
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Restore Pen

To restore a *.bak file containing data, applications and

components to your QuickLink Pen or to transfer them from

one Pen to another via the backup copy on the computer:

1. Turn your Pen on and select PC-Controlled Commu-
nications from the Pen Main Menu.

2. Select Restore Pen from the Pen Communications
menu (or select CTRL+R). The Open dialog box appears.
e If communications between your QuickLink Pen

m and computer fail, an error message appears when



you select Restore Pen. Try running the Communi-
cations Wizard to correct the communications setup.
e Ifthe QuickLink Pen you have connected is not

recognized by the Desktop, you are prompted to
use the current Pen, choose an existing Pen or
create a new Pen name.

3. Click on the backup file you want.

4. Click on Open.

5. When the confirmation message appears, click on Yes.

Note: Do NOT abort the Restore Pen process before it is
completed. Failure to complete the process may result in
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the loss of all data, applications and components from
your Pen.

Optimizing the Pen File System

When you delete data, such as an Address or Note, from your
Pen, the area that was used by the data is not actually deleted
from the flash memory. The Optimize Pen File System
option enables you to free up those areas on the Pen’s flash
memory that are no longer being used by application data.

To use this option:

1. Turn your Pen on and select PC-Controlled Commu-
nications from the Pen Main Menu.

2. Select Optimize Pen File System from the Pen
Communications menu. A progress bar appears on the
computer that displays the progression of the optimiza-
tion process.

e If communications between your QuickLink Pen
and computer fail, an error message appears when
you select Optimize Pen File System. Try
running the Communications Wizard to correct
the communications setup. m



»  Ifthe QuickLink Pen you have connected is not
recognized by the Desktop, you are prompted to
use the current Pen, choose an existing Pen or
create a new Pen name.

3. When the process is complete, click on OK.

Note: Do NOT abort the Optimize Pen File System
process before it is completed. Failure to complete the
process may result in the loss of all data from your Pen.
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Part 4: Appendices
Additional QuickLink Pen Information
Upgrading the QuickLink Pen

The QuickLink Pen, which comes with a 2MB flash

memory card, is upgradeable to more flash memory to

accommodate a large number of additional components. The

following steps should be taken when upgrading your Pen:

1. Back up your Pen. (See the section, Backing Up and
Restoring Pen Data, Applications and Components, above.)

2. Turn your Pen off.

Remove the battery compartment cover on the back of the Pen.

4. Using the lever supplied with the upgrade kit, gently
remove the flash memory card.

5. Plug in the new flash memory card and replace the
battery compartment cover.

6. Restore the data to your Pen. (See the section, Backing
Up and Restoring Pen Data, Applications and

(O8]

Components, above.)

Note: If you do not back up your Pen prior to upgrading
it, you will be unable to restore your previous Pen data,
E applications and components to your new flash memory card.



Care and Cleaning

Your QuickLink Pen conforms to the highest standards of
craftsmanship and manufacture. To ensure its continuing
excellent performance, please adhere to the following
instructions for care and cleaning:

e Protect your QuickLink Pen from direct sunlight, heat,
dampness and dust. Do not drop or knock the device;
keep it in its protective plastic case to avoid scratches.
ALWAYS replace the protective cover of the Pen tip
when not in use.

¢ Clean the Pen only with a soft, dry cloth. Never use a
wet cloth or solvents such as benzene or diluting agents.

* NEVER clean, wipe or tamper with the Pen tip. It
contains a sensitive electronic eye that could become
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damaged.
e Should your Pen require servicing, contact the retail
outlet where you purchased your unit.

Batteries
Your Pen uses two AAA batteries. To check the batteries,

select Battery status from the Pen’s Information menu.

If the batteries are low, a picture of a battery with a slash
through it appears on the QuickLink Pen display. When the
batteries are about to run out, the Pen shuts down automatically.

When replacing batteries, use only high-quality alkaline
batteries, or rechargeable nickel cadmium batteries.
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Pen Technical Data

Processor ARM 7 TDMI
RAM memory 64 to 192KB
ROM memory 2MB

Flash memory 2MB

Socket for flash memory 2MB/4MB/

cards 8MB (upgradeable)
Serial communications IrDA and RS232

Optic head 128 pixels linear
array image sensor
400 DPI resolution

Display dimensions 61mm x 20mm/

24”7 x.87122x 32
pixel resolution

Supply voltage Two 1.5v AAA batteries
Weight 90 grams/3 oz.
(not including batteries
and/or flash memory card)
Size Length (with cover):

163 mm/6.4”
Width: 38 mm/1.5”
Height: 23 mm/1”

* Low power consumption

* Compliant to FCC class B
* Compliant to CE standards
UL listed




QuickLink Desktop Requirements

*  Windows® 95/98 or Windows NT

* 16 MB RAM or higher

* Internet Explorer 4.0 or higher for synchronizing
Internet Links

Troubleshooting

Problem:

The Pen doesn’t scan.

Solutions:

*  Check to see whether the Pen is turned on and is in
scanning mode, and the protective cover has been
removed from the tip.

* If you previously were using the Opticard, make sure
you switched out of Opticard mode prior to returning to
normal scanning.

Problem:
The text in the Pen display appears upside down.
Solution:

Adjust the Pen to right-handed or left-handed use.

Problem:

The words you want to scan are in a format too large or
small to scan, or the text is printed unclearly.

Solution:

Use the Opticard.

Problem:

An error message, “Excessive Light”, appears on the
display.

Solution:

Move the Pen away from the strong light source (such as
sun, lamp, etc.) shining directly on the tip.
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Problem:

An error message, “Scanning Too Fast”, appears on the
display.

Solution:

Scan more slowly.

Problem:

The computer is unable to communicate with the QuickLink
Pen because the serial port is busy.

Solutions:

*  Close other applications that are using the port.

*  Run the Communications Wizard

* Restart the Desktop

* Restart Windows.

Problem:

The Pen and computer do not communicate:

» Data is not exchanged during the QuickLink function.

* Applications are not added or removed from the Pen.

* Pen data is not backed up or restored.

Solutions:

* In the Desktop application, make sure that Pen commu-
nications are on.

*  Run the Communications Wizard.

e Make sure that the QuickLink communications cable or
IrDA device is attached properly to both the QuickLink
Pen and computer.

* Make sure that the same communications settings are
defined on both the QuickLink Pen and computer.

* Make sure that your computer supports the baud rate
defined on the Pen. If not, a lower baud rate should be
selected.

e Make sure that QuickLink or PC-Controlled Commu-
nications is selected on the Pen.



Problem:

Scan to PC mode does not work.

Solutions:

* In the Desktop application, make sure that Pen commu-
nications are on.

e Make sure that the QuickLink communications
cable or IrDA device is attached properly.

¢ Make sure that the Scan to PC application was
selected on the QuickLink Pen.

Problem:

The QuickLink process works, but results in errors.
Solution:

Check the QuickLink log to view the type of errors that
occurred during the process. Host errors may occur because
the selected host application is not installed on your
computer.

Problem:

The QuickLink process works, but the results are not what
you expected.

Solution:

Check QuickLink settings for the Pen.

Problem:

The Add/Remove Pen Components, Backup Pen, Restore
Pen and Optimize Pen File System functions are disabled
in the Desktop application.

Solution:

Make sure that Pen Communications are on on the Desktop.

Problem:
You accidentally deleted standard components from your
QuickLink Pen.
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Solution:

Restore the deleted components to your Pen using the
backup copy on the CD-ROM, according to the instructions
in the section, Restoring Components to Your QuickLink
Pen from the CD-ROM.

Problem:

The Interface Language option in the View menu is
disabled.

Solution:

Additional interface languages are not installed to the
QuickLink Desktop installation folder. Run Desktop setup;
install the additional interface languages if they are
available.

WizCom Web Site

The WizCom web site is located at
http://www.wizcomtech.com. Contact us to remain
up-to-date about applications, dictionaries and other
components for your Pen.



Glossary

Term

EXPLANATION

Baud rate

The speed (bits per second) at
which data is transmitted.

Character set

A comprehensive series of
characters used to represent a
language (e.g., Latin character set
for English, Cyrillic character set
for Russian, etc.)

Current Pen/file etc.

The Pen, file, etc. that is currently
displayed and accessible for
adding data, editing, etc.

Field

An item of information within an
application. E.g., First Name in
Address Book, Description in
Internet Links, etc.

Flash memory

The memory chip on the
QuickLink Pen, containing Pen
applications, components and
data files.

Host application

A software application on your
computer, other than the QuickLink
Desktop, to which you transfer data
from your Pen. E.g. Microsoft®
Outlook® for addresses.

IrDA

Infrared Data Association; an
industry standard that has become

synonymous with infrared technology.

Glossary
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Insert Mode

Mode of entering characters in
which the new characters are
inserted between the existing ones
at the cursor location.

OCR

Optical Character Recognition:
computerized method of
recognizing scanned text and
converting it into editable format.

Operating system

The software that runs the
applications and functions of the
QuickLink Pen.

Overwrite mode

Mode of entering characters in
which the new characters replace
the existing ones.

Record A unit of related data, such as an
Address or an Internet Link.
ROM Read-Only Memory: memory

that cannot be changed or erased,
containing the Operating System.

Serial port

Socket at the back of a computer for
attaching communication devices.

Wizard

A interactive series of instructions
in the QuickLink Desktop.




Index
A

Accented characters, 66
Add and Remove Pen
Components, 70, 82-86
Address Book, 18, 38-51
About, 27
Addresses Menu, 27
Auto Advance, 23
AutoName, 23
Delete Address, 28
Delete File, 27
Edit Address, 29
Editing entries, 54-55
Exit, 27
Field Settings, 25
Find Address, 27
Main file. See Mainadd
New Address, 22
New File, 26
Next Address Language, 24
Open File, 26
Scroll Screen, 23
Select Fields, 24
Select Search Language, 28
Settings, 25
View Address, 28
View Addresses, 22
Auto Shut-Off Time
Change, 48

Backup Pen. See Pen: Back up
Batteries

Inserting, 8

Replacing, 93

Status, 50
Blinking red light, 12

C

Cable
Connecting, 16

Character Bar, 66-68
Alphabet sequence, 64
Deleting characters, 65, 67
Entering accented characters, 66
Insert Space symbol, 66
Multiple Characters button, 65
Numbers, 64
Punctuation, 64
Single Character button, 65
Using a different character set, 67
Character set, 64, 67, 68, 77
CharacterEyes Limited, 1, 15
Cleaning. See Pen: Care and cleaning
Communications. See PC-Controlled
Communications
Pen settings, 47
Problems with, 96
Communications settings, 80-82
Baud rate, 48, 81
COM port, 81
Connection device, 47
Communications Wizard, 14
Compact Pen. See Pen: Compact
Components
Accidentally deleted from Pen, 97
Deleting from Pen, 85
Confirmation message, 10
Connection device, 47
Contrast, 49
Conventions, 5
Current Pen. See Desktop: Set
current Pen

Index

D

Deleting characters, 67
Desktop

Add Pen to, 78

Editing, adding or deleting

records on, 75

Exit, 17

File menu, 72

Help menu, 72

Installation, 14—16 m
Menu bar, 71



Index

Pen Communciations menu, 72
Remove Pen from, 79
Rename Pen on, 79
Reorder applications on Pen, 89
Running, 17
Set current Pen, 79
Status indicator icon, 75
System requirements, 95
Text size, 77
Toolbar, 73
View menu, 72
Desktop window, 74
Application pane, 74
Current file pane, 74
Files pane, 74
Disabled functions, 97, 98
Double-click, 9, 54, 55, 56, 57
Double-click interval, 49

Edit Menu. See Editing commands
Edit Mode, 29, 34, 52, 58
Editing commands, 58-63
Activate Overwrite Mode, 58
Clear Line, 58
Delete Line, 59
Delete Paragraph, 59
Insert Column, 59
Insert Line, 60
Insert Row, 60
New Paragraph, 60
Remove Column, 61
Remove Row, 61
Resume Editing, 61
Scanning Options, 61
Electronic eye, 1
Erasing highlighted text, 52
Error message, 10
Excessive lighting, 95

F

Flash memory, 1, 88, 92
Flush Pen files, 44

G

Glossary, 99

H

Host application, 18, 26, 31, 41, 42
Quicklinking with, 42
Host folder, 43

Icons, on Pen, 49
Information, 50-51
Insert Mode, 58
Installation Wizard, 14
Interface language
Change on Desktop, 72, 76
Change on Pen, 47
Internet Links, 18, 32-34
About, 33
Auto Advance, 30
Auto Describe, 31
Delete File, 32
Delete Link, 33
Edit Link, 33
Editing entries, 55-56
Exit, 32
Links Menu, 33
Main file. See Mainlnk
New File, 31
New Link, 29
Next Link Language, 31
Open File, 32
Scroll Screen, 30
Settings, 30-31
View Link, 33
View Links, 30
Inverse text, 25, 40, 62
IrDA communications, 81
Connecting infrared device, 16



K
Keypad, 8
L

Language
Desktop interface, 7677
Pen interface, 47
Scanning, on Pen, 47
Left-handed use. See Scanning:
Right-/Left-Handed use.
See Scanning: Right-/Left-Handed use Log
Close, 86
View, 72
Long-press, 9, 37
Long-press interval, 49

M

Main Menu, 18, 86
Mainadd, 26
Mainlnk, 31, 32
Memory
Compact, 50
Status, 50
Menu type
Change, 49
Movie, 1, 15
Multiple lines, 60
Multiple Lines, 62

Multiple Pens, 42, 78

N

Notes, 18, 21-22
About, 21
Delete File, 21
Edit Current File, 20
Editing, 53-54
Exit, 21
New File, 20-21

Open File, 21
Numeric, 25, 40, 62

o)

OCR, 1
Off line, 80
On line, 80
On-line Help, 72, 77
Operating system

Upgrading, 87
Opticard, 68—69

Changing scanning language

while using, 69

Optimize file system. See Pen:
Optimize file system
Overwrite Mode, 58

Index

P

PC-Controlled
Communications, 19, 46
Pen
Back up, 90
Care and cleaning, 93
Compact, 86, 88—89
Cover, 8
Default settings.
See Preferences
Optimize file system, 91
Parts, 6
Restore, 90
Serial number, 50
Version number, 51
Pen Communications, 80
Pen Customization Wizard, 14
Pens dialog box, on Desktop, 78
Power button, 11

Preferences, 47-50

Q

QuickLink, 41-46
Errors, 97



Index

Host settings, 4344

PC to Pen, 45

Pen to PC, 45

Settings, 41-45

Starting the process, 46

Synchronize, 44

Unexpected results, 97
QuickLink CD-ROM, 1, 82

QuickLink communications cable.

See Cable
R

Registration, 17

Reorder Pen applications. See
Desktop: Reorder applications
on Pen

Restore Pen. See Pen: Restore

Restore Pen components (from

CD-ROM), 86

Right-handed use. See Scanning:

Right-/Left-Handed use

S

Scan Only Mode, 52
Scan to PC, 19, 38-40
About, 40
Exit, 40
Problems with, 97
Scanning Options, 40
Send Immediately, 39
Settings, 39-40
Scanned too fast, 96
Scanning
Instructions, 11-13
Limitations, 10
Pen angle, 12
Pen readiness. See
Blinking red light
Right-/Left-Handed use, 48
Scanning language
Change, 24, 31, 63, 69
Scanning Options, 25, 61

Inverse, 62

Multiple Lines, 62

Numeric, 62

Select Language, 63
Scanning problems, 95
Select Language, 63
Serial number. See Pen:

Serial number

T

Tables, 18, 34-37
About, 37
Auto Advance, 35
Delete File, 37
Edit Current File, 34
Editing, 56-57
Entering data, 35-37
Exit, 37
New File, 35
Open File, 37
Right to Left Table, 35
Scroll Screen, 34
Settings, 34-35
Technical data, 94
Troubleshooting, 95-100

U

Upgrading
Operating system, 70, 87
Pen, 92

Upside-down text, 95

\'

View Mode, 23, 28, 30, 33, 51

w

Warranty, 1, 6
WizCom web site, 98



